Canon

Digital Video Software [Windows

Instruction Manual

Canon

Flease select the area in which you live,

(/USA, Canada, South America

— e —

o
| Europe, Middle East, Africa |
\‘\: — 4
( Asia

Oceania A

Version 22




| Contents

Read This First ...t irrme s s s s s s s s s e s s nmm e e e nmnns 4
Checking Supplied ACCESSONIES ......ccoeiiiiieieieeee e 4
System Requirements ... 5
What is Digital Video Software? ... 6
L0 8 T Lo 7
CamMEraWINAOW ......ccoeiiiiiiiieee ettt e e e e e e e e e e e s e e nnnreeeees 7
[Acquire Images] Tab ... 7
[Print] TAD .. e et eeeenees 8
[Setto Camera] Tab ......ooooiiiii e 9
Camera Browser WINAOW ..........ueueiiiiiiire e e e e e 10

MAIN WINAOW ...ttt nneennnnes 11
[IMmage VIeWer] WINAOW ..........oouiiiiiiiiieeeeeee et 15
[Red Eye Correction] WINAOW ...........uuuiiiiiiiiiiiiiiee et 16

[Auto Adjustment] WINAOW ........cooiiiiiiii e 17
[Color/Brightness Adjustment] WINAOW ..........cooviiiiiiiiiiiiiiiieee e 17
[Sharpness] WINAOW ........coooiiiiiiiiieeeeeeee e e e e e e e e e e 18

[Trim IMage] WINAOW ... e 18
[INsert TEXt] WINAOW .....cooniiee e 19
Installing the Digital Video Software ... 20
Before Downloading Still Images ... 25
Connecting the Camcorder to @ Computer.......oouiiiii i 25
Downloading Still Images (ZoomBrowser EX) .........cccceviiiiinimimimnssnssssessssssssssssnnees 27
Starting CameraWiNAOW .........cooo oo 28
Using the Computer to Download Still Images ............ccoooo oo 29
AUto-Downloading .......ooooe i e 29
Auto-Downloading Settings .........cooiiiiiiiiiiiiiie 30
Downloading the Selected Still Images from the CameraWindow .................. 33

Using @ Card Reader/WIILEr ......coovioiiiii et 36

Using the Camcorder to Download Still Images (Direct Transfer Function) ........ 37
DIreCt TranSTer .o 37
Setting the Direct Transfer Download Destination Folder ............................... 38
Printing Still Images..........cccooiiiiiii i 40
Printing Still Images Recorded on the Disc or Memory Card...........cccccvvvvernnnnnne. 40
Printing Still Images Downloaded to the Computer .............cccooiiiiiiiiiiiiiiiiiee, 45
[One Photo perPage Print] ... 45

LT =3 4T 1 47
Organizing IMages ... ..o s 49
Applying Star Ratings and Keywords.........cccoooooiiiiiiiii e 49
Classifying the IMages. ... 50
Renaming MUItiple Files ..o 52
Searching for IMagEsS.......cooo it 54
Creating a Movie from the Still Images.......cccuveecciiiiiiini s 57
EdItiNG MOVIES ... 57
Playing Back MOVIES. ... 61
EXPorting ImMages ... s 63
Changing the File Type and Save...........oooo s 63
EXPOMING MOVIES ...t e e e e e e e e e 67
Extracting Still Images from Movies (Windows XP Only)...........cccceeiiiiiiiiiininnnnnnn. 70
Saving on CD-R/RW Disks (Windows XP ONly)........cceveeeiiiiiiieieiiieiiiinineineninnnnnns 73

2 I Contents



Adding Still Images to the Memory Card in the Camcorder
Adding Still Images to the Memory Card ............ooovviiiiiiiiiiiiie e
Adding Card Mix Sample Images to the Memory Card .............cccoeeeeriiiinnnnnnnn.

Using Various FUNCLIONS ... s

Merging Panoramic Images (PhotoStitch) ...

Attaching Still Images to E-mail Messages

RUNNING @ SHdE SNOW ......coiiiiieie e

Adding Sound to a Still Image

Reviewing and Changing the Owner Name of the Camcorder..............ccco.......... 90
Uninstalling the Software.............coo e 92
Uninstalling ZoomBrowser EX ... 92
Uninstalling the TWAIN Driver/WIA DriVer.........oooooiiiieeeeeeee, 93
TroubleShOOtiNgG .......cooiiiiie e 94

Contents I 3



| Read This First

B Disclaimer

» While every effort has been made to ensure that the information contained in this
guide is accurate and complete, no liability can be accepted for any errors or
omissions. Canon reserves the right to change the specifications of the hardware
and software described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

« Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software, memory
cards (miniSD Cards), personal computers, or peripheral devices, or due to use
of a memory card not initialized by a Canon camcorder.

B Trademark Acknowledgments

» QuickTime is a trademark of Apple Computer, Inc.

« Microsoft® and Windows® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

* miniSD is a trademark of SD Card Association.

» Other names and products not mentioned above may be registered trademarks
or trademarks of their respective companies.

© Canon Inc. 2006 All rights reserved.

B Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support data
CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could

damage the speakers. It is also possible to suffer from hearing loss from listening
with headphones to the loud sounds of a CD-ROM played on a music CD player.

Checking Supplied Accessories

Use the following accessories to download recorded still images from a memory card
to your computer.

* IFC-300PCU USB Cable * DIGITAL VIDEO SOLUTION DISK

The explanations in this manual use mainly Windows XP screen shots. The steps
and windows may vary depending on your computer and the version of software.
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| System Requirements

Please install the software on a computer meeting the following minimum
requirements.

0OsS: Windows 98 (Second Edition)
Windows Me
Windows 2000 (Service Pack 4)
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
* Proper operation is not guaranteed on an OS that has
been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.

CPU: Pentium 500 MHz or better

RAM: Windows 98/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/Windows

2000/Windows XP systems with built-in USB ports

Free Hard Disk Space: + Canon Utilities
- ZoomBrowser EX: 200 MB or more
- PhotoStitch: 40 MB or more
» Canon DV TWAIN Driver: 25 MB or more
* Canon DV WIA Driver: 25 MB or more

Display: 1024 x 768 pixels or better/High Color (16 bit) or better

@ O Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
\&¥] o Proper operation is not guaranteed on any particular system, even if it meets
the requirements outlined above.
o A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

Microsoft® Windows® 98 Second Edition: Windows 98
Microsoft® Windows® Millennium Edition: Windows Me
Microsoft® Windows® 2000 (Service Pack 4): Windows 2000
Microsoft® Windows® XP Home Edition or Professional

(Service Pack 1 or 2): Windows XP
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| What is Digital Video Software?

The following software will be installed by installing the Digital Video Software.

B ZoomBrowser EX

* Viewing downloaded still images

» Categorizing, organizing, and searching large volumes of still images
« Editing still images

* Changing the data for still images and save them as new files

* Viewing still images in a slide show

» Adding sound to a still image

B CameraWindow

» Downloading still images from a disc or a memory card to your computer

* Viewing still images recorded on a disc or a memory card

* Printing still images recorded on the disc or memory card without downloading
the still images to the computer

B PhotoStitch

Merging a series of overlapping still images into a single, seamless panorama

B USB Driver

« Driver software that enables you to download still images from a disc or a
memory card to a computer. Users of Windows XP do not need to install this
driver software. An OS standard driver will be installed automatically.

* Windows 98/Windows 2000: Canon DV TWAIN Driver

* Windows Me: Canon DV WIA Driver

This instruction manual explains how to install the software, what you can do with the
main features and how to operate them. For more detailed operational instructions,
refer to the Help menu of each software program.
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| Windows

CameraWindow

CameraWindow is a program created to download still images from the disc or

memory card to the computer. Furthermore, you can print still images recorded on the
disc or memory card without having the images downloaded to the computer ([_] 40),

and you can confirm and change the

([1190). Refer to Starting CameraWindow ([ ] 28) for launching the software. The

owner name of the camcorder you specify

Remote capture function is not supported by the camcorder.

B [Acquire Images] Tab

This tab is used for downloading still images recorded on the disc or memory card by

connecting a camcorder or a card reader/writer to the computer.

Selects a function in the Camera ——
Control window.

Images will be downloaded to
the computer, and ZoomBrowser EX
starts.

Images in the camcorder are
displayed allowing you to select
images.

Camera Control window

¢ CameraWindow - Canon -E ko

" Acquire Images | Print | Setto Camera | Femate shooting '

Downloads uzing camera

\J&N Press the camera's button
|- P

| Downloads using computer
| I‘__
o Starts to download images

‘ =

Lets you select and download images

PIaCing a check mark here makes e /| Digplays this soreen when the camera is connected

the Camera Control window to open
automatically the next time you

Preferences...

connect the camcorder.

Specify the image type to be downloaded and
the destination folder.
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B [Print] Tab

This tab is used for printing still images on the disc or memory card without having the

images downloaded to the computer. The window varies depending on the selected
printing type. Refer to Printing Still Images Recorded on the Disc or Memory Card

(11 40).

Camera Control window

& CameraWindow - Canon, A4 ok ok

Prints all still images in the disc or —
card one image per page.

Acquire Image&l Fririt | Set to Camera | Remote shooting |

Prints all still images in the disc or —
card as an index page (rows of
images with file names and image

Print All Photos

information).

Prints according to the DPOF print —
settings set by the camcorder to the
still images recorded on the card.

Print Contact Sheet with All Photos

Print according to DPOF settings

Displays a list of the still images ——
in the disc or card, allowing you
to select which ones to print.

Select an image and print

Dizplays thiz screen when the camera iz connected

Prefarences...

=)
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B [Set to Camera] Tab

This tab is used for confirming and changing the owner name of the camcorder you
can specify ([] 90) and uploading the still images to the card. My Camera function is

not supported by the camcorder.
@ CameraWindow - Canon ¥ ¥k k % | - : E

| Acauire Images | Print | Setto Camera | Femate shooting|

Camera Control window

Set My Camera

o

Confirms/changes camera settings

Enter or change the name of
the camcorder’s owner.

EEE
&

Uploading the images from the _|'j§_lu Uploads images to the camera
computer
Digplays thiz screen when the camera is connected
2Py Selecting [Manage My Camera] from the [Edit] menu displays the [My Camera]

d window. If you click [Creating My Camera data] in the [My Camera] window,
[My Camera Maker] will be launched. [My Camera Maker] is a program that
enables you to create and import My Camera contents (Start-up images, Start-
up sound, Shutter sound, Operation sound and Self timer sound) to
camcorders that support this function. Your camcorder does not support the My
Camera function.
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B Camera Browser Window

Prints the selected still images.
Starts ZoomBrowser EX.

Selects the still image selection method.

Changes the size of the thumbnail.

& CameraWindow - Ca

File{F) Edit(E) Wiew(¥) H

piH)

=Y 'p 2 =
Q Image Download annt - @StartZoomBrowser Ex

_# | File Information:
File Mame:  IMG_0101.JPG
o @ N?odlffed: 20034074157 4:45:2
File Size: 20KR

Image Size:  E40x480

# | Histogram:

Se

g

H-.-IE_I:II:H.._IF'E IMG_0102.PG IMG_0103.PG IMG_0104.PG

_ﬂ Details:
Ttem Mame Value A
File Mame IMG_010

Camera Model M., Canon
Shoating Date)Ti... 1f15/200
Shoating Mode Partrait
Fhoto Effect Off

T (Shutter Speed) 140

Ay (Aperture Wal... 2.0

Light Metering Evaluativ
Exposure Comp.,, O
150 Speed Auko

' Lens 2.6- 851
Focal Length 7.9 mm
Digital Zoom Mone
Image Size E40:430

Image Quality Fine

{jl,__ | }jl

Selects imag| 1 of 4

=

‘

Selects whether to show or hide the image
frame and file name.

Still image information and a histogram
(This will not be displayed when using a card reader/writer.)
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Main Window
ZoomBrowser EX is a software program used for organizing, printing and editing the
downloaded still images. If you wish to start ZoomBrowser EX without connecting the E

camcorder or card reader/writer, double-click the on the desktop, or click the

ZoomBrowser
Windows [start] menu and select [All Programs] » [Canon Utilities] » [ZoomBrowser
EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click £ or select [Exit] from

the [File] menu.

7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents g@@
File_Frit Yirw Tanls _Tnbernet Heln
e o
Tasks @ ﬂ@ Wiew Image Properties [}/ Slide Show "Q Search ﬁ? Delets :‘%I Ratats ]
. | > \
@ oquine b Camera Satngs fZDﬂm Mode | Scrollbods | Preview Mode | | — - 5
= lMyD nnnnnn ts € 4+ H-0- '__\_"!‘{ J,(———"‘ Show | Al Images vJ
1 —— 7 vewsisssiv
E 200<_01_15 Iy Music
Edit
@ Export 4
@_ Fiint
s
Internet
IMG_D102.0PG

(( Favarte Folders | Al Folders )

=-{EF Desktop " y‘.
2 — == My Documents e
By 8 MG_0103.PG  IMG_0d
j Ty Music
% My Pictures
B My Computer My Pictures
3 Search Resuls
[ Add to Favrt ]‘
\ - = — M . — —
Selscted Items: 1

[Acquire & Camera Settings]: Use this to display the Camera Control window to
download still images, to print still images without
having them downloaded to the computer and to
configure the camcorder settings.

[View & Classify]: Use this to view and organize still images.
[Edit]: Use this to edit still images.
[Export]: Use this to change the data for still images and

save them as new files, extract still images from
movies, back up to CD-R/RW (Windows XP only),
or export shooting properties to a text file.

[Print]: Use this to print downloaded still images.
[Internet]: Use this to attach selected still images to E-mail
messages.
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2 Folders Area

You can select a folder to be displayed in the Browser Area. | ¥ indicates that
newly downloaded still images are in the folder.

Selecting the [Favorite Folders] tab shows only the folders that are registered as
Favorites. To register folders as Favorites, follow the instructions below.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].
When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

To remove the registered folder, select the folder, and click [Remove].

3 Browser Area

This area displays the images contained in the selected folder. If you place the
cursor over a thumbnail in the browser area, will be displayed at the upper right
corner. Clicking skips over folders to zoom in directly on the intended folder.

o Clicking on 2 images while holding down the [Shift] key selects also all
images between the 2 images.
o Clicking on different images while holding down the [Ctrl] key selects multiple
images.

4 Browser Area Tool Bar
The menu items vary depending on the View Mode.

1 2 3 4 5 6 7 8

L1 A |
R-0- |k R =4 M 2Ll |- ]-‘_ Show | Al Images "

1 | Previous/Next Displays the previous/next image in the current folder.

2 |Up Displays the folder in the upper tiers of the hierarchy.

3 | Select Allows you to select all images and deselects images.

4 | Information Allows you to select the information to be shown. You can
also hide the pop-up window by clearing the checkmark.
The pop-up window appears when you move the mouse
over a thumbnail.

5 | Pan Changes the area displayed when you zoom in on a folder

or image in the Browser Area and drags the thumbnail list.

6 | Restore Display | Changes the size of the thumbnail list to fit the window.

Size
Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.
Show Allows you to select displayed images according to the

star rating.
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View Mode
You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

ZaomMade | ScrollMode | Preview Mode|

s € > 2 (BH-0-[n&Q et Sow [ Mg v

3] 200%_01_15 My Music:

IMG_0103.0PG  IMG_0104.3PG

[Scroll Mode]: Thumbnails of the images are displayed next to the folder name.
Clicking a folder displays enlarged images. Selecting [Preferences] from the
[Tools] menu opens the [Preferences] window, on which you can select the
hierarchy of folders.

Zoom Mode | Sl Made | Preview Mode

My Documents € > 42 B0 L Show | 4lmeges 2
Elzoox_m_m mﬁb 1000
| _} My Music ¢ [naimages) o=, 0[], 00
| :,' My Pictures i [noimages] o=, 0[], 0010
i

[Preview Mode]: A large image is displayed along with detailed information. You
can change file name and comments. To display another image, click [Previous]/
[Next] or select an image shown at the bottom of the window.

Zoom Mode | Scroll Mods | Previsw Mode |

200K 01_15 € 4 - @ Show | Alllmages 2

~

File Informatian
FieName: | IMG_0101
Madfiedt 1716/200%
File Size 228KE
Image Sz B40x 480
DetaType: PG

[Z] Star Rating:
[ Protect

(%] Commert:

(] Keywords
ViewModily Keywords

[A] Brightniess Histagram;
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6 Application Tool Bar

1 2 3 4 5 6

| . I
|E Yigw Image Properties =] ,?,} Slide Shaw "& Search ﬁ? Delete ng Rakate

View Image Displays a selected image in the [Image Viewer] window.

2 | Properties Displays properties of the selected still image. When you
select a different image while the [Properties] window is
open, the information switches to the one of the selected
image. The [Properties] window cannot be displayed in
[Preview Mode].

o Properties
Modified: 1/15/2005
File Size: 828KB
- Image Size: B40 » 480
;‘ Data Type: JPG
Sound
Wiew Image.

Pathe  C:\Documents and Settings\CanonbMy Docy
=] File Name:
IMG_001
[&] Star Rating
[ Protect

[&] Comment:

[F] Kepwords
View/Modily Keywerde ..

[&] Brightness Histogram:

[Z] Shooting Information:

ltem Hame Value A
File Name IMG_0101.PG
Camera Model Name  Canor oo
Shoating Diate/Time - 1/15/200% 24523 Ph
Shooting Modz Partrait

Photo Effect oK

Ty (Shutter Speed) 1240

b [dnerthre Wal el 2n

He

IS

Slide Show Displays still images in a slide show.

Search Allows you to search for images ([ ] 54).

Delete Deletes selected images.

ol A W

Rotate Rotates selected still images. A movie cannot be rotated.
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[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View Image]
or double-click an image.

13
14
15 =

10 = @ (=) &
1" —J I
12 -

2 34 5 67 8 9
|@|M||M ||
|

M 8 | e (5o 11 (T 1T () &8 svmchvone
B me_nwonare

Zoorn Ratio: 100%

Previous/Next

Displays the previous/next image in the current folder.

Zoom In/Zoom Out

Enlarges/decreases a still image.

Pan

When the image is larger than the window, you can move
the image in the desired direction.

Print

Prints the selected still image. Refer to [One Photo per
Page Print] ([T 45).

Edit

Allows you to perform the following operations: red-eye
correction, auto correct, color and brightness correction,
sharpness adjustment, trimming, inserting texts or
registering external image editing applications.

Auto Focus Frame

This function cannot be used for the images recorded by
the camcorder.

7 | Shooting The shooting information of the image will be displayed.
Information
Show Allows you to display multiple images at the same time.
Synchronize Synchronizes the View functions across all displayed
images.
10 | Fit to Window Matches the image size to the size of the Image Viewer
Window.
11 | Restore Restores the standard display size.
12 | Zoom Slider Allows you to enlarge/decrease the displayed image.
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13 | Show Image Full Displays an image in full screen size.
Screen

14 | Change the Star Allows you to change the star rating.
Rating

15 | Capturing Frames | Extracts still images from movies. (Windows XP only)

B [Red Eye Correction] Window
Selecting [Red Eye Correction] from the [Edit] menu or the =i~ icon allows you
to correct the red eye effect on a still image in the [Red Eye Correction] window.

=] Red Eye Correction - C:\Documents and SettingsiCanonikly Documentsi200X 01 15UMG ... ‘zl@@

1
2
[] Show Driginal Image
%)@ & O | m -
- Co= )
Auto Mode Clicking [Start] corrects the red eye effect automatically.
2 | Manual Mode Point the cursor on a red eye so that the area is
highlighted green, and left-click the mouse.
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B [Auto Adjustment] Window

Selecting [Auto Adjustment] from the [Edit] menu, or clicking the &= - icon and
selecting [Auto Adjustment] allows you to automatically correct the color balance of

the still image.

(=] Auto Adjustment - C:ADocuments and SettingsiCanoniMy Documentsi200X_01_153MG_01... \E”X‘

ORIy

Auto Adjust Image

Shaow Original Image

B [Color/Brightness Adjustment] Window

Selecting [Color/Brightness Adjustment] from the [Edit] menu, or clicking the
e - jcon and selecting [Color/Brightness Adjustment] allows you to adjust the
brightness, saturation, contrast, intensity levels, tone curve and RGB of the still

image.

Please select adjustment option:

| Color Adjustment ~

B t’ Saturation ‘7j

Brighiness —— |- |0 %

Contrast _J
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B [Sharpness] Window
Selecting [Sharpness] from the [Edit] menu, or clicking the e - icon and
selecting [Sharpness] allows you to emphasize and clarify the outlines of people
and objects.

Sharpness - C:\Documents and SettingsiCanon\My Documentsi200X_01_15%MG_0104. IPG i:‘E”g‘
“Shapen | Unsharp Mask |
Amaunt: J u 5
R QM| E

B [Trim Image] Window
Selecting [Trim] from the [Edit] menu or the [ - jcon allows you to crop a still
image. Either drag the mouse on the image or specify the cropping area, and click
[Trim Image].

(=] Trim; Image - C:WDocuments and SettingsiCanon\My Documents'200X_01_154MG_0103.JPG |Z|@@

Tiim settings:

Location (bop-left comer):

% [0

v [o
Srodimrmae
wil |

=
H |0

Elhader ™ | m [

Cancel
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B [Insert Text] Window

Selecting [Insert Text] from the [Edit] menu, or clicking the &=~ jcon, and select
[Insert Text] allows you to write text on still images.

Insert Text - C:\Documents and Settings\Canoniby Documentsh200X_01_15\MMG_0104. JPG |:“E||g‘

Insert Text:

Fant Name: rial R
Font Size 48 R

Text Color (|

Text Attribute; B 7 O

Arlialias

Text:

«<Select the location on the image first, then
tupe pour text in heres
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| Installing the Digital Video Software

(D)

O Be sure to install the Digital Video Software before connecting the
camcorder to the computer.

o Users of Windows 2000 or Windows XP must first log in as an Administrator
to install programs.

Windows XP Users:

Your digital video camcorder is equipped with the standard Picture Transfer

Protocol (PTP). This protocol enables you to download still images by simply

connecting the camcorder to a computer with the USB cable (the software such

as the [Scanner and Camera Wizard] starts automatically).

However, please note that there are several limitations to downloading still

images with this method. To avoid these problems, install ZoomBrowser EX to

download still images.

0 It may take a few minutes, after connecting the camcorder, until you can
download still images.

o Still images protected on the camcorder may lose this setting once they are
downloaded to the computer.

Check a camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be
installed normally. If a camcorder is connected, detach the USB cable from the
computer.

Set the DIGITAL VIDEO SOLUTION DISK in the computer’s
CD-ROM drive.

If the installer panel does not open automatically, use the following procedures
to display it.
- Windows 98/Windows Me/Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
Depending on the setting of your computer, the file extension “.EXE” may not
appear.

Select your country or region.

Select your language.

Installing the Digital Video Software



5 Click Digital Video Software [Easy Installation].

To select the installing software, click [Custom Installation].

Installer Panel — Canon DIG"ALVDEO E
Solution Disk

Digital Wideo Software
( Easy Installation
- /

Automatically installs sl software.

Custom Installation
_/

Select the software that you want to install.

QuickTime .5
( install )
"

Exit

6 If other software is running, close all programs and click
[OK].

Start installing Digital Yideo Solution Disk,
Close any other open applications and click [Ok].
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T Review the installation settings and click [Install].
When you have selected [Custom Installation], depending on the Windows OS,
you need to have one of the following USB drivers installed on your computer.
Please select and install the appropriate driver.
» Windows 98/Windows 2000: Canon DV TWAIN Driver
* Windows Me: Canon DV WIA Driver
* Windows XP: No driver is necessary to be installed.

Confirmation

=
@ ZoomBrowser EX 155 MB

p2 License =
@ Photostitch 40ME
= . 5 |
step 3 Installation ai/ EOS Utility 20ME
stepd  Finish

Viewr a description of the software by passing yaur mouse aver the name of the
software.,

C:\Program Files\Canor,

Click [Install] to start installing.

‘ Back |

o When installing the software on Windows 2000 or XP by selecting [Easy

<# Installation], EOS Utility (a software for downloading still images from the
Canon EOS Digital SLR Cameras) will be installed. This software is used only
for compatible Canon EOS Digital SLR Cameras, and the camcorder does not
support this software.

8 Read the license agreement and click [Yes] to accept the
terms and to start installation.

License Agreement

Please read the following License Agreement carefully before instaling the
saiftuiare

License

IMPORTANT MOTICE
This software conkains the Adobe color profiles (Adobe RGE(1998),Appls RGE,
ColorMatch REB, Wide Gamut RE8),and which are licensed under the following

stepd  Installation Adohe SYSTEMS INCORPORATED COLOR PROFILE LICENSE AGREEMENT, This
software other than such Adabe color profiles s licensed undsr the Following
Canon Software License Agresment.

stepd  Finish

CANOM SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ CAREFULLY BEFORE INSTALLING THE SOFTWARE! This
document is & legal aqreement (*Agresment") betwean you and Canon Inc,
(“Canen") and goverring yaur use of this softwars, and online manual ar ather
electronic dacumentation, and saund data and image data, if any (the "Software").
BV INSTALLING THE SOFTWARE, YOl AGREE TO BE BOUMD BV THE TERMS OF
THIS AGREEMEMT. IF ¥OU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
PROMPTLY STOP THE INSTALLATION PROCESS,

1. GRAMT OF LICENSE

(1) Canan grants you a nan-exclusive license o use ('use” shall mean storing,
laading, instaling, executing, or displaying) the Software an your computers solely

far use with Canon product. You may allow other users of Canon's product touse v

Click [Yes] to accept the License Agreement, If you click [No], the installation
of Digital Video Solution Disk will be canceled.

o (= )
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9 click [OK].

m ZoaormBrowser EX
Installed
m .| Photostitch
Installed
Installation ol EOS Utiity
m /  Installed
V ZoomBrowser EX

 PhotoStitch
 EOS Utility

stepd  Finish

10 When the installation is complete, select [Restart computer
immediately (Recommended)] and click [Restart].

|| Installation of the software has been completed.

t H ( Restart computer immediately (Retnmmended))
l : Ul T m
7

When you do not need to restart the computer, the [Finish] screen will be
displayed. Click [Finish]; remove the DIGITAL VIDEO SOLUTION DISK from
the CD-ROM drive, and proceed to Before Downloading Still Images ([ ] 25).
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11 When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO SOLUTION DISK
before you connect the camcorder to the computer.

2¥y Windows 98/Windows Me/Windows 2000: At this point, the files for the TWAIN
2 Driver or WIA Driver have only been copied to your computer. To download
images via USB connection, finish installing the TWAIN Driver or the WIA

Driver. For details, see step 6 ([ 1] 25) in Connecting the Camcorder to a
Computer.
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| Before Downloading Still Images

Connecting the Camcorder to a Computer

@ O Be sure to install the Digital Video Software before you connect the
\ o /| camcorder to the computer.

O Make sure the camcorder is being powered using the power adapter before
connecting it to a computer.

o Connect the USB cable directly to one of the computer’s main USB ports.
The interface may not function correctly if the camcorder is connected via a
USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

O Do not connect two or more camcorders to the computer. The camcorders
may not operate normally.

O Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface.

2%y © Refer to your computer manual for the location of the computer’s USB ports.

d 0o See your camcorder instruction manual for how to connect the camcorder to
the computer and how to change the media setting (MEDIA SEL.f3) in the
SYSTEM SETUP menu.

Insert a disc or memory card containing images into the
camcorder.

Connect the power adapter to the camcorder.

Turn the power switch to ON and change the camcorder
mode to PLAY by sliding down the power switch.

Move the '™ /¢y to 1.

AT h O GWON -

To download still images on the disc select DISC in the
MEDIA SEL.f3 from the SYSTEM SETUP menu.

To download still images on the card select CARD in the
MEDIA SEL.3 from the SYSTEM SETUP menu.

Wait until the camcorder’s access indicator stops flashing.

6 Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
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* The first time you connect the camcorder to the computer:

- Installation of the DV TWAIN Driver (Windows 98/Windows 2000) or the DV
WIA Driver (Windows Me) starts.

- If the “Digital signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.

* Windows 98/Windows 2000/Windows XP: A window appears allowing you to
select an application program to start.
Windows Me: The Scanners and Cameras Wizard starts. Click [Cancel] to
close the Wizard.

* For instructions on how to start ZoomBrowser EX and download images to the
computer, see Downloading Still Images (ZoomBrowser EX) (1] 27).

USB Terminal USB Cable

-~¢— Camcorder End Computer End —»

USB Port on
the Computer
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| Downloading Still Images (ZoomBrowser EX)

’0\ O Proper operation when connecting to a computer or printer cannot be E

¥ guaranteed if the disc inserted into the camcorder was recorded or used in a
non-Canon digital device.

o Observe the following precautions when the camcorder’s access indicator is
flashing. Failure to do so may cause disc or memory card data to become
corrupted.

- Do not open the disc or memory card cover, remove the disc or memory
card or detach the USB cable.

- Do not turn off the camcorder or the computer.

- Do not change the position of the power switch or the "™ /3 switch.

o Images recorded onto the disc, memory card or downloaded to the hard disk
are important original data files. Create a copy of the file first before working
on it on your computer.

O For Windows XP Users:

- Do not rotate the image in the [Windows Picture and Fax Viewer] or in the
explorer view. The data for the original image will be changed and the
image can no longer be displayed in ZoomBrowser EX or on the
camcorder.

- If the Server Busy window appears when you connect the camcorder to the

computer, click [Retry].

: Thig action cannot be completed because the other
' program iz busy, Chooze "Switch To' to activate the
o buzy program and correct the problem.

O You cannot connect the camcorder to a computer if the disc or memory card
contains more than 1800 images. When using a memory card, please use a
card reader/writer to download the still images; for the disc, please use your
computer’s DVD drive. When using the DVD drive to download the images
recorded on the disc, it is necessary to insert a finalized disc.

- You cannot record any new images on the finalized DVD-R disc or
unfinalize it.

- For instructions on how to connect a card reader/writer, see Using a Card
Reader/Writer ([ 1] 36).
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Starting CameraWindow

1 Connect the camcorder to the computer ([1] 25).

2 Select [Canon CameraWindow] and click [OK].

« If a camcorder and card reader are connected at the same time, a dialog
appears allowing you to select the camcorder model. Confirm that [Canon
Camera] or your camcorder model name is displayed and click [OK].

Canon ¥ # %% %

Camera connected

Select the program to launch for this action;

i [
@J R

<i7jg) Microzoft Scanner and Camera Wizard
Download pictures from a camera or scanner

[ éshwayz uze this program far this action

» The Camera Control window opens.

&5\ CameraWfindow - Canon 44+

'Acquirelmages Frint Settoaﬂera Remate shooting

Dowrloads uging camera

‘1' & Q&N Press the camera's button

=t et

‘ [Downloads using computer
| @l Starts to download images

it i
j;?—l Lets you select and download images

[¥] Diisplays this screen when the camera iz connected

2% © If the camcorder is already connected to the computer, you can start the
&7 CameraWindow and display the Camera Control window by clicking [Acquire
& Camera Settings] followed by [Connect to Camera] in the ZoomBrowser
EX Main Window.
o The Remote shooting function is not supported by your camcorder.
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Using the Computer to Download Still Images

You can select a downloading method in the Camera Control window.

B Auto-Downloading E

1 Click [Starts to download images] in the Camera Control
window.

* For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ([I] 30).

» Click [Finish] to close the Camera Control window after downloading images.

& CameraWindow - Canon k343 %

Acquire Images | Print | Setto Camera | Remote shooting

Dowrloads using camera

WL ] \-'-’JQN Press the camera's button

ﬁ v
| = Lets you select and download images

[Diizplays this screen when the camera is connected

Freferences...
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B Auto-Downloading Settings

Select the setting for downloading images by operating your computer. You can
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon

' | Acquire Images |!=‘rinl Set to Camera | Remate shooting |

’ Dowrloads using camera

¥ Q‘QN Press the camera's button

Displays thiz screen when the camera iz connected

2 Select [Change auto download settings] and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

() Change direct transfer downlaad destination folder

(C Change auto download settings )

Cancel
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3 Select the image type to be downloaded and click [Next].

CameraWindow - Auto Download Settings(1]

Select the image type to be downloaded.

(%) New images

() All images

() Images whose print order settings were specified with the camera

() Images whase bransfer settings were specified with the camera

Download Options

= | Wwhen the download iz complete, the original image iz deleted fram the camera.

Place a check mark here ——
if you wish the original image
in the camcorder to be

deleted after downloading. (oo et D[ oo

@ o The still images recorded on the disc will not be marked as “already
\ o/ transferred” after downloading.
o When downloading from the disc, the still images on the disc will not be
deleted even if the [Download Options] is selected (a check mark is placed).

4 Specify the destination folder settings and click [Next].

CameraWindow - Auto Download Settings(2)

Specify the location at which to save the image.

Destination Folder
A new falder will be created for each of the images' shooting dates in the following folder,

and the images wil be zaved there.

s - sDocurnents and SettingzCanony DocumentsihMy Pictures

o
Click this button Browze. .
o SpeCify the Create Subfolder
destination fOIder. I-ihooting ‘YeartdonthDate v:
E=ample:
SeIeCt tO Specify = | |‘_E_:'\Documer'uts and SettingsiCanontty Documentsiy Pictures
|1 200 _01_15
the name of the
subfolder.

< Back Cancel

Downloading Still Images (ZoomBrowser EX) I 31



5 Specify a process to perform after the image is downloaded.

CameraWindow - Auto Download Settings{3)

Specify process to perform after image is downloaded.

(%) Display the folder at the save destination

() Perform zelected processes consecutively

< Back Cancel

Below window will be displayed when you select [Perform selected processes
consecutively] (You can redisplay the window by clicking [Select]). Select a
process to perform after the image is downloaded, and click [OK].

sSelect Process

Fleaze zelect a task to wn after pour images
have been downloaded:

%) View az a Shide Show
() One Photo per Page Print
(73 Index Frint
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6 cClick [Finish].

E3

CameraWindow - Auto Download Settings{4)

Enable or disable the image auto-download function. E

Placing a CheCk mark " | Images are automaticaly dawnloaded to computer while camera iz connected
here makes images in
the camcorder to be
automatically downloaded
when the camcorder is
connected.

< Back Cancel

B Downloading the Selected Still Images from the CameraWindow

1 Click [Lets you select and download images] in the Camera
Control window.
The CameraWindow opens.

& CameraWindow - Canon 3 3ok

Acquire Images & Frint | Setta Eamer;"Emote shooting

Dowrloads using camera

Wi ] \;’J&N Press the camera's button
g —

5y
%QJ Lets you select and download images

Diizplayz thiz screen when the camera is connected
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2 In the CameraWindow, select the image you wish to
download and click [Image Download].

* Clicking on 2 images while holding down the [Shift] key selects also all images
between the 2 images.

» Clicking on different images while holding down the [Ctrl] key selects multiple
images.

& CameraWindow - Canon &% F4 &
File(F) EditE) Wiew(¥) Help(H)

- = = _# | File Information:
-\j@ Image Download ‘bs Print ;ﬁ Start ZoomBrowser EX File Name:  IMG_0101JPG
- Modified: 200x/01/1514:49:28
B Select - = U5 =@

File Size: BOKB
Image Size:  B40x480

_# | Histogram:

A blue frame
appears around
the selected image.

IMG_0102.JPG IMG_0103.JPG IMG_0104.JPG

# | Details:

Ttem Mame Vale A
File Hame IMG_010
Camera Model N...  Canon
Shodting DatefTi... 1/15(200
ShootingMode  Partrait
Photo EFfect Off

Tv (Shutter Speed) 140

Av (Aperture Yal... 2.0

[ ——

Light Metering Evaluatiy
Expasure Camp. .

130 Speed Auto

Lens 2.6-65.1
Focal Length 7.8 mm
Digital Zoom Mone
Image Size 640480
Image Quality Fine o
< >

Selects image 1 of 4

2P [Delete] from the [Edit] menu and # will not be active when transferring the
& IS images recorded on the disc.

3 Confirm the settings and click [Starts Download].

« ZoomBrowser EX starts, and the downloaded images appear in the Main

Window.
Camera¥Window: - Download Images
Specify Folder
Save to (Folder Name)
) CADocuments and Settingz'Canon' My Documents
Setting for the folder and the
. Create Sub Falder
subfolder for downloaded images
Shoaoting veartdonthD ate
| Specify File Name \
Settings for the fiI_e prefix 1| Do ot modiy
and the consecutive numbers J
[ Change Settings. .. ]
7 \!
(m [ Cahicel ]
v_

» To make changes, click [Change Settings].
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[Specify Folder] Tab

CameraWindow - Change Settings

Specify the settings of
the folder and subfolder.

[Specify File Name] Tab

Specify the file name at ——zrom— speciy Fie Name |

which to save the images.

Specify Folder | Specify Fils Name |

Save to [Folder Mame)

|E:\Documents and SettingstCanontMy D ocuments | [ Brawse... |

A subfolder into which the image will be zaved will automatically be created in this folder.

Create Subfolder
| Shooting YeartonthD ate w |

MNew Hame
|"-.:;.-.: |

Example;

G CADocuments and SettingshCanon'skdy Documents
-] 200%_01_15

ag. ] ’ Cancel

Cameralindow - Change Settings

Specify File Mame:

MG

Azzigh Sequence Mo

Murnber af Digit . (1-9]
r [0
Example
[ filee stenzion will be the same agithe tnginal file name]

(19 ] [ Cancel
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B Using a Card Reader/Writer

The basic operations are the same as when you connect the camcorder to the
computer. Follow the procedure below to open the CameraWindow. For instructions
on how to connect the card reader/writer, please refer to its manual.

If your card reader/writer does not support miniSD cards, please purchase an
appropriate adapter for the card.

1 Insert a memory card containing images recorded with the
camcorder into the reader.

2 Windows 98/Windows Me/Windows 2000: Click the Windows
[Start] menu, and select [Programs], [Canon Utilities],
[CameraWindow], [CameraWindowMC] and
[CameraWindow].

Windows XP: When a window appears allowing you to select
an application program to start, select [View/Download
Images using Canon CameraWindow] and click [OK].

2P Clicking [Acquire & Camera Settings] » [Acquire Images from Memory Card]
“Z in the Task Area of the Main Window of ZoomBrowser EX also opens the
Camera Control window.

3 Select a downloading method.

* [Starts to download images]: The progress bar will be displayed and images
will be downloaded to the computer, and ZoomBrowser EX starts. For
instructions on how to set the Auto-download settings, see Auto-Downloading
Settings ([11] 30).

* [Lets you select and download images]: The CameraWindow opens,
displaying the camcorder images as thumbnails (small images).

& CameraWindow - G:\DCIM

| Acquire Images | Print

Starts to download images

Lets you select and download images
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Using the Camcorder to Download Still Images (Direct
Transfer Function)

If your camcorder supports the Direct Transfer Function, you can use the camcorder to
download images. EI

B Direct Transfer

1 Select a transfer option on the camcorder screen and press
the 0~ button.

» See your camcorder instruction manual for how to set and operate the
camcorder to transfer images.

* For instructions on how to change the destination folder and the folder name,
see step 3 ([ 31) in Auto-Downloading Settings.

« The [y button cannot be used when it is not lighted.

* You can set the action that is carried out for direct transfer. Right-click the
[CameraWindow(Launcher)] icon on the taskbar and select an action from the
displayed menu.

- [Show image(s) in fullscreen
mode]: v Show imagels] in fullscreen mode
Displays downloaded images in |  Launch ZoomBrowser EX
full screen mode. —_

- [Launch ZoomBrowser EX]: v Show Window

Starts ZoomBrowser EX after — —_— =

downloading the images. | About CameraWindow(Launcher). ..
- [Show Window]: I s %

The Camera Control window Exit
appears when you connect the B v %
camcorder to the computer.

2 Press the )~ button on the camcorder.
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B Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon, &8 4% %

' | Acquire Images |!:‘rinl Setto Camera | Remote shoating |

Daownloads using camera

v o\\-JJQIN Press the camera's button

=
|=-;::"'\:u—

Downloads using camputer

Starts to download images

i i
jgl Lets you select and download images

Diizplayz thiz screen when the camera iz connected

| Preferences... |

2 Select [Change direct transfer download destination folder]
and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

(@ Change direct transfer download destination folder )

() Change auto download settings

Cancel
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3 Specify the destination folder settings and click [Finish].

CameraWindow - Auto Download Settings{?)

Specify the location at which to save the image.

Destination Folder
A new folder will be created for each of the images' shaating dates in the following folder,

and the images will be saved there.

C:\Documents and Sett

CI|Ck thIS button Browsze...

to SpeCify the Create Subfolder

destination fOIdeI'_ - Ghooting YearMonthDate v|
Erample:

SeleCt tO specify P ﬁ[:Ej\DzoDCDL;meg;s1aEnd SettingzhCanonby Documentsibdy Pictures

the name of the

subfolder.

< Back Cancel
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| Printing Still Images

Printing Still Images Recorded on the Disc or Memory
Card

You can select one of the following 4 methods to print still images in the disc or card
without downloading images to the computer.
* [Print All Photos]

- Prints all still images recorded on a disc or memory card in the connected

camcorder or in a card reader/writer one image per page.
* [Print Contact Sheet with All Photos]

- Prints all still images recorded on a disc or memory card in the connected
camcorder or in a card reader/writer in an index (rows of images with file names
and image information).

* [Print according to DPOF settings]
- Prints according to the DPOF print settings set by the camcorder.
* [Select an image and print]

- A list of the still images recorded on a disc or memory card in the connected
camcorder or in a card reader/writer will be displayed, and you can select images
you wish to print.

1 Connect the camcorder to the computer. ([1]25)

2 Click the [Print] tab in the Camera Control window.

& CameraWindow - Canon 3k ok

Acquire Image etto Camera Fﬂote shooting

Dowrloads using camera

W Q&N Press the camera's button
L.~

| Downloads using computer

Starts to download images

Lets you select and download images

[¥] Displays thiz screen when the camera is connected
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3 Click one of the 4 printing methods.

& CameraWindow - Canon 43 %

i

Rl | B} ]
| Acquire Images| Fritit | Set bo Camera | Remate shooting | E

Print All Photos

[n

Print Contact Sheet with All Photos

Print according to DPOF settings

e [

/LR

Select an image and print

J

Diizplayz thiz screen when the camera iz connected

4 Specify the print settings and click [Print].

The window varies depending on the selected printing method in step 3.
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When you have selected [Print All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

Frinter FPrewview

- (& B =
t Trim Image

Canan D
| KAHHA | Fiatate Left  Ratate Righ

Properties...

(MediaType:

|Plain Faper v|

Faper Size: -

| Letter b |

Orientation:

\‘@ Porrait O Landscape

Tatal: 4 pages
Fage Layout Settings

Auto Trim

[ Bordetless

Select additional information
to printwith your images:

[[] Shoating Date
[[] Shoating Time

Text Color: (|

4 | Image: 1/ 4 E
L

]
Cancel

Click this button to switch between still images

Sets the auto trim if multiple images are selected.

(crops image edges

according to the page — Sets the number of print copies of the displayed image.
proportions) or

borderless print settings. =—Sets the shooting date/time imprint and color settings.
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When you have selected [Print Contact Sheet with All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

index rin Sotigs I &

Frinter Sreniew

MName: : -|_:|J_
C v
| kbt —| Fotate Left Fotate Richt | Trim Image

Properties...

Media Type:

| Plain Paper
Faper Size:
| Letter |
Orientation:

O Forrait O Landscape

-~

Copies: j1 2

Tatal: 1 pages

Fage Layout Settings

Colurnns: 3

Fiowes: 3

<3| |2

.

f
[¥] Shooting Infarmation

[IHeadet/Footer
. 4 g - _— Y
4 Page: 1/1 »
1 ]
Sets the print settings Click these buttons to switch between pages.

for shooting information,
comments, headers,
footers and page
numbers.

—— Sets the number of print copies of the contact sheets.

Sets the number of rows and columns.

When you have selected [Print according to DPOF settings]:

* The selected still images will be printed according to the number of copies set with
the camcorder. The same window described in the previous section When you have
selected [Print All Photos]: (L[] 42) will be displayed.
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When you have selected [Select an image and print]:

* If you selected [Select an image and print], the following window will be displayed.
Select still images you wish to print, and click [Print]. If you selected [Contact Sheet
Print], the same window described in the previous section When you have selected
[Print Contact Sheet with All Photos]: ([ ] 43) will be displayed. If you selected [One
Photo Per Page Print], the same window described in the previous section When you
have selected [Print All Photos]: ([1]42) will be displayed instead. Set the print

settings and print the still images.

&8 CameraWindow - Canon, 3 3 5
File{F) Edt{E) Wiew(y) Help{H)

By select - = }
elecl / File Size:  8OKB

Image Size:  GA0«480

ﬂ Hiztagram;

IMG_0101JPG IMG_0102.JFPG IMG_0103.PG IMG_0104.JFG

""—_‘\ ) -;j\ —— _# | File Infarmation:
__}éf‘ Image Downlo(d L‘ﬁ Print = ﬁ Start ZoomBrowser EX File Mame:  IMG_0101JPG

w3 Modified:  200:/01/1574:45:28

b

5 _& | Details:

Them Hame Walue A
File Mame IMG_010
Camera Madel M., Canon s
Shoating Date/Ti... 1f15f200
Shoating Mode Portrait
Phioto Effect Off
Tv (Shutter Speed) 1540
Ay (Aperture Yal,,, Z.0
Light Metering Evaluativ
Exposure Comp... 0
150 Speed Auto
Lens 2.6-65.
Focal Length 7.2 mm
Digital Zoom MNone
Image Size 40430
Image Cuality Fine e

1B

_—_Selects image l.of

4
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Printing Still Images Downloaded to the Computer

You can select one of the following 2 methods to print still images downloaded to the
computer.
* [One Photo per Page Print]
- Prints one still image per page.
* [Index Print]
- Prints selected images in rows with file names and image information.

You can select the program to use for printing by clicking [Print] in the Main
; Window and selecting [Print Using Other Software].

B [One Photo per Page Print]

1 Click [Print] in the Main Window and click [One Photo per
Page Print].

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

Flle Edit View Tools Inkernet Help

[ Tasks 2] [f,jp Slide Show ‘Q Search
@ Acquire & Camera Settings ] zZoomiklode | Seroll Mode | Preview Mode — S —— =
—- My Documents L 4+ K-0- |_§_|"tﬁ J,—-—”“ Shaw | Al lmages -
Iﬁﬁi} iew & Classity ] [ FE——
. 3} 200%_01_15
Edit
l@ Export ]

@_ Frint

e, =

| One Phata per Page Print )

1= — —

ﬁdex Frirt

| Fiint Using Other S oftware ] / |
Intemnet } | I | m_ _ =

1

2 Select still images you wish to print and click [Printer and
Layout Settings].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniyy Doc uments

Fil= Edit View Tools Intermet Help

|_[ 2 Retum to Main Menu ]
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46

3 Specify the print settings and click [Print].

Sets the paper size and orientation. Rotates still images.

Click this to use the trimming function

Selects the printer.
(crops a portion of the still image).

7 ZoomBrowser, EX - C:\Documents and SattingsiCan| hiMy Documents ‘z”i”z‘

File Edit WView Tools Internet Help

Help

One Photo per Page Print STEP 2: Sp| [eify Printer and Layout Setting

1. SelectImages Frinter

MName

Printer and Layout Setlings iCanDﬁ W00k v

( ‘3. Fint > Properties

Fuotate Left  Rotate Right

Media Type
iP\am FPaper V|

Paper Size:
| |Lener vl
1|9 Retun to Main Menu _ i
Orientation

@Faortrait O Landscape

Taotal: 4 pages

FPage Layout Setiings

Auto Trim
[ Barderless

Select additional information
to print with your images:

[] Shooting Date

[ Shooting Time

Text Color: [

Copies: |1 \C_.

4 Image: 1/ 4
|

Click this button to switch between still
images if multiple images are selected.

Sets the number of print copies of the displayed image.

Sets the shooting date/time imprint and color settings.
Sets the auto trim (crops image edges according to the page proportions) or borderless
print settings.
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B [Index Print]

1 Click [Print] in the Main Window and click [Index Print].

1 ZoomBrowser EX -

File Edit View Tools Internet Help

C:\Documents and Settings\Canony Documents

! Delete 3

@-
8
&~

LD ne Phato per Page Frint

| Index Print

Print Using Other S oftware

o)
|
|
|
|
|

i

-

| . Internet ]

[ Tasks | e Image -‘l Froperties @ Slide Show @ Search Raotate
e A e g Zoom Mode | Seroll Mode | Preview Mods | .
My Documents < + m -0 - ILIQ }_ Shaw | &lllmages v
ﬁ “Wiew & Classify
3] 200%_01_15 My Music

IMG_0103.0PG  IMG_0104. PG

and Layout Settings].

7' ZoomBrowser EX -
File Edit View Tools Internet Help

Index Print

C:ADocuments and SettingsiCanoniby Documents

Zoom Made [ Scroll Mode || Preview Mode|

Select the still images you wish to print and click [Printer

r_‘[—:
A

L

2.

&

Select Images

Printer and Layout Settings

Pririt

L

3 Retum to Main Menu

W

My Documents

€ 1w o-[h]a W

Y et Show | Allmages 2

Pri

inting Still Images
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3 Specify the print settings and click [Print].

Sets the paper size and orientation. — Rotates still images.

Selects the printer.

Click this to use the trimming function
(crops a portion of the still image).

&7 ZoomBrowser EX - C:\Documents and SettingsiCan| My Documents ‘:HEHZ‘

File Edit Wiew Tooks Inkernet Help

 Printer and Layout Setiing

Help

1 1. SelectImages Frinter

MName

l Printer and Lavout Settings ‘

| Canon xoxx ~|
benes.

Media Type

:P\am FPaper

Faper Size

| Letter
| 91 Retun toMain e :

Orientation
@ Partrait O Landscape

opies: |1 ]

|

Total: 1 pages
Pace Lavout Sefings
—
(Cnlumns I3 =
kRows: IS :;

Shooting Infarmation

Settings...

[ HeaderFooter

Fage: 1/1

p— . |
b

Click these buttons to switch between pages.

Sets the print settings for shooting information, comments, headers, footers and
page numbers.

Sets the number of rows and columns.

Sets the number of print copies of the contact sheets.
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| Organizing Images

Applying Star Ratings and Keywords E

This task allows you to apply ratings to your images from one star to three stars. The
Star Rating can be used as one of the search conditions, or for the selection of images
to be displayed in the Browser Window. The keyword can be used as one of the
search conditions.

1 Select the image to which you wish to apply the Star Rating
or Keyword, and select [View/Modify Keywords] from the
[Tools] menu.

Manage Keywords, .,

Skitch Phokas, ..

Cuskamize, ..
Preferences...

2 Place a check mark next to the keyword you wish to apply,
or click on the stars for rating.

1 View/Modify Keywords

Check or uncheck the boxes to chanage the way Kewwords are applied to the selected filez. To add a new Kewword, type the name in the

test field below the desired eategony, and press the + buttan

People: Flaces Ewents: Others: R
[ Children | Beach | [ Birthdlay

] Family ] Gty ] Haliday

| Friends | [ Home ] Party

= J
Select the star rating to azzign to the selected files

Cepes

Y O The default setting of the Star Rating is two stars.
4 0o You can display images according to Star Rating by selecting [Filter by Star
Rating] from the [View] menu.
O You can add and delete keywords, or change the keyword list in the [Manage
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
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Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents
File Edit Yiew Tools Internet Help

[ Tasks Q]| BB venimaze [ properes @ Side Show @SEar’Eh Delete [ Rotate

1 7
t@ Aequire & Camera Seftings J Zoom Made | Seroll Mode | Preview Mode| -
My Documents € L J E -0 - ‘Ll@; ! J._ Shaow | All Images -
@ iew & Clagsify

r@ Edi j ¥} 200%_01_15 R
| B
|
|

l@ Export
l@ Frint
l Internet

2 Click [Classify into Folder].

IMG_0101.0PG IMG_D102, PG

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents

File Edit Yiew Tools Intermet Help

| [ Tasks @ ] Irrage P @ Slidz Shiow \Q Search

@ et At e Zoom Mode | Scioll Mode | Preview Mode | - R
| -\L by Documents + L] g - 0 - ‘ k @& -]r---""' Show | Al Images -
E— iew & Clagsify l

3] 20m<_m_15

View az a Slide Show l

Rename biult |p|e Files J

~

—

r| \|

Classity inta Folder ]

— s

= ]

3 Select the images you wish to classify and click [Specify
Classification Settings].

&7 ZoomBrowser EX - C:\Documents and Settings\Canoniy Documents
Fil= Edit View Tools Intermet Help

% Classify into Folder

Select Images

Zoom Mo | SctllHods | Fieview o]
by Documents € %+ EW - Q- ‘Ll& -]r---"'" Show I-Eﬁmages vl

o |
%,

AEE IMG_0102.PG

—
2 Specll_l,l Classification Settings

My Music

o 1

_(A

3. Finish

i [ 3 Retum ta bain Menu
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4 Specify the folder structure and the saving folder and click
[Finish].

The selected images are classified into the specified folder.

&1 ZoomBrowser, EX - C:\Documents and Settings\Canoniiy Documents
File Edit Wiew Tools Internst Help

f [ (= > il ngs
Select Images ?'JECW Folder Structure When classifying by shooting \
i date. ZoomBrowser EXwill only

i Specify folder structure:
‘ n: TS classify photos with shooting

Specify Classification Settings

—] A — |YearMnnthDale V‘ date infarmation and skip over
== = .
. -> 'y photos without shooting date
< 3. Finish | Ei . 'J Example Folder Structure infarmation.
v 1 E} & ChiDocuments and SettingsiCanoniby Documents
200%_00_15 By default. ZoomBrowser EX

copies the original photos to the
new folders. To save space on
wour computer, choose fo move
the photos instead

“1 Return to Main Menu

Sawve to Folder

LJ Where would you like these folders to be created?
) @ Current Falder
'F:' O My Pictures

O Specity Folder

‘C.\Ducumenta and SettingsiCanoniiy Documents

Copy or Mowe Images

- '—:f—a‘.s - @ Copy
a&:“:ﬁ “—"Ea'?i I_&f Q%‘ | O Move /
= |
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Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and copy
multiple files.

1 Click [View & Classify] in the Main Window.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents

File Edit Yiew Tools Intermet Help

[ Tasks Q] ViewTnage  [EF| Properties @Shde Shaw @ Search Delet= (3% Rotat=

t@ e A i J Zoom Mode | Serall Mode | Preview Made|
| —— —
'}ﬁj: “Wiew & Classify

My Documents € L 'E -0 - ‘_k_l@t Jr—"'"‘ Show | All Images -
[ e -~
¥ 200%_01_15 My Mo
r@ — 7 D Y Fluzic
| A |
l B

l@ Export
l@ Frint
l Internet

2 Click [Rename Multiple Files].

IMG_0101.0PG IMG_D102, PG

{7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents

File Edit ‘iew Tools Intermet Help

[ Tasks

@ Acquire & Camera Settings
rﬁ “Wiew & Classify

Wiewn &z & Slide Show

@ Slidz Shiow @ Search

Zoom Made | Seroll Mode | Preview Mode

My Documents € L :Q -0 - IE' ""'1 Jr--—"" Show | AllImages w

3 200%_01_15

—\

7/ \l
_J.l_‘”

Rename Multiple Files

Clazsity inta Falder

MG_I101.IPG  TMG_D1002,
il [ ,.J

Search

3 Select the images you wish to rename and click [Specify
Rename Settings].

w1 ZoomBrowser EX - C:\Documents and Settings\Canoniby Documents

File Edit Yiew Tools Internet Help

@ RBename hMultiple Files
= N

Zoom Mode | Serol Mode | Preview Mode
Select Images e

— ———— = My Docurments L T E& -0 - ‘Il'i!\ _].-—-'"—' Shiow | All Images V|
2

‘ STEP1: Select Images

. Specily Rename Settings

. Epﬂux_uu 5 My Music
3. Finish
AR ! |
S} ras

o

r
\

;,4[ I Retum to Main Menu
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4 Specify the settings and click [Finish].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents |Z”E”‘X‘

File Edit View Tools Internst Help

\% Rename Multiple Files ecify Rename Settings Help

1. Select Images

Renaming your photos can

Select how files should be renamed: [:;ljzrsearchmg TEAE e

Specify Rename Settings
— - © Mew Mama + Number

] < 3. Finish \>‘ 234.JP5 © Shooting Date + Number
‘ = © NewMName + Shooting Date + Number 123.JPG 456.1PG

© Shooting Date + New Name + Number 2 4

] Make copies of files
AN JPG A 002 JPG
Specify name NEWNAME
—— By default ZoamBrowser Ex
Mumber of digits ‘3 | creates and renames copies of
1|9 Retum to Main Mefu ] e the ariginal photos. To save
Start number; ‘1 | space on your computer,

choose to rename the original
photos instead

Example of new file name:

NEWNAME_001 00
\ MNOTE: The original data type (00 will be retained. /

Placing a check mark here makes copies of images with new names.
The name of the original images will not be changed.

2P Torename a folder, select a folder, and open the [Rename Folder] window by
& selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images
This task allows you to search for images by Star Rating, Modification Date, Shooting
Date, Comment or Keywords.

1 Click [View & Classify] in the Main Window.

You can also search for images by clicking [Search] on Application Tool Bar.
Please skip forward to step 3.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents
File Edit VYiew Tools Intermet Help

[ Tasks

L@ Acquire & Camera Settings
1

(7 iew & Classify
N —————
r@ Edit

l@ Export

l% Frint

l Internet

)

:! € 4 |HE-0-(h8 e Show [ Allimages
jj 3] 20m<_m1_15

|

|

|

,’jp Slidz Show \Q Search

Zoom Mode | Seroll Mode | Preview Mode|

My D ocuments

MG_0101.0PG IMG_D102, PG

2 Select folders and images from which you wish to search
and click [Search].

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniy Doc uments
File Edit View Tools Internet Help

[ Tasks

_@]:

Propetties DFSth Show @ Search ﬁ Delete 3

Zaom Mode | Serall Mode | Preview Mode |

% P St |G D! 7_= e how [ Allmages
View as 3 Slide Show l a: 1
|

l Rename Multiple Files ‘ ‘

Clazsify inta Falder J
> =
D ]
Edit “ |

My Documents

©
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3 Specify the search conditions and click [Start Search].
» The search results are displayed as thumbnails.
* Select at least one search condition.

o' ZoomBrowser EX - C:\Documents and Settings\CanoniMy Documents

File Edit Yiew Toals Internet Help

STEP 2 Specify the search canditions

@ Search
| 1. Select Search Region @ HMaich all canditions © Match any conditian

Specify Search Conditions

Star Rating

Find images with the selected star rating

= Star Rating + v

[ Modification Date

Findirmages based on the date they were last modified

[ 9 Fetum 1 bain Menu

] Shooting Date

Find images based on the date they were shot

[ Comment
Find images that hawve comments containing the following words.

[ keywords
\ Find images you have tagged with keywords J

4 cCiick [Finish].
 To change the search parameters and perform another search, click [Specify
Search Conditions] and repeat steps 3-4.

&7 ZoomBrowser EX - C:ADocuments and Settings\Canoniy Doc uments

Help

i

Select Search Region

2. Specify Search Conditions

L Start Search J
-

1.1PG IMG;D”Z.JPG 103 PG IMG_0104.0PG

1 o~
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» The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder.

‘ [nternet

| Favorite Folders | All Folders
ERE | Deskkop
=) My Documents
%) 200%_01_15

5;"' My Music
(% My Pictures

z _T-' 7 o~
2 Search Results

O The searched images will remain in this folder until ZoomBrowser EX is closed
‘4 or another search is performed, but if you delete an image in this folder, the
corresponding original image will be deleted as well.

e
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| Creating a Movie from the Still Images

Editing Movies

You can link still images, insert text and background music, and add effects. You can E
also change the size of selected movies and save them as new files.

VG‘ o If you are not using Windows XP, QuickTime 6.5 or higher is required to edit
\ o/ movies. If it is not already installed on your computer, install it from the
DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click QuickTime 6.5 [Install] in the installer panel.
o If you have an AVI file in your computer, you can use this function to edit the

file.

1 Click [Edit] in the Main Window.

7 ZoomBrowser EX - C:\Documents and Settings\Canoniky Documents

File Edit ‘iew Tools Inker tH\p

[Tasks @]
@Aq & & Camera Settings

l E"_ “wiew & Classify

Zoom Mods | Serall Mode | Preview Mode|

My Documents

,rjp Slide Shows \Q Search

I

o
B |
& |

2 Click [Edit Movie].

|

#7 ZoomBrowser BX - C:ADocuments and SettingsiCanonihy Documents

File Edit View Tools Internet Help

[ Tasks : @] m

@ Acquire & Camera Settings ] | Zoom Mode Scioll Made | Preview Made

[F"‘- My Documents
V7 view & Classity l

L

l Edit Image

L titch Phatos
|
=

T - e
opefties DF Slide Shaw ‘a Search ejate

€ L ] l‘é -0 - ‘7‘7;'5{ _]-—)"'_‘ Show .AII.\.mages

My Mugic
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3 Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents

STEP 1. Add images Help
Zoom Maode ‘ Seioll Mode ” Preview Made |

by Documents € > 4 |@' 0'|Q "’5{ M | :El: D-‘ |Shuw

File Edit VYiew Tools Internet Help

3 Apply Eftect

4. SetAudio

4 Arrange images and click [Apply Effect].
To change the order of images, select an image in the Storyboard Area and click
[Move Left] or [Move Right].

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents

File Edit ‘iew Tools Internet Help

........... Help

1. AddImages . . )
Ta arange images. select the image and dlick on i
buttars

Amange

(3. ApplyEffect

To get the play time or ot

4. SetAudio

] [ hotete |

Total Time: 00:10

Selected Ikems: 2 |

Plays back the movies Storyboard Area

being edited. Displays thumbnails of the
selected images. The images will
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.
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5 Apply effects to the images and click [Set Audio].
When you select [Apply effects to image.], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text,
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.

- [Transition Effect]: Opens the [Transition Effect Settings] window. You can
set the transition effect type and display time, and preview the effect. To set
a transition effect, you need to select a transition box in the Storyboard Area.

7" ZoomBrowser EX - C:\Documents and SettingsiCanoniy Doc uments

File Edit View Tools Internet Help

1. AddImages (O lse imane a3 is

® Apnl}l effects to image.

|#lmq To set the Text eflect Filter effect, ar to maanify a section, select the image and click the
5
( il Filter Effec J [ Magrify Section |

Text Effect

2. Arange

|

|

Apply Effect :]
;‘4

[ =

=
“wihen pou want to zet the image's Transition effect, select the [Transition Effect] box
:_4 Sl click. the [Transwtlon Effect] buttan.
8 Save Transition Effect

6. Exit l

6 Set the audio and click [Save].
When you select [Set audio.], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add a MP3 or a WAV
file as background music.

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can
adjust the audio level of a movie or an audio file and apply audio faders. To
set the advanced audio settings, you need to select a movie or an audio file
which you added.

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents

Fil= Edit View Tools Intermet Help
—/)

Voo immacole aniddio daba oo e

&) Set audio.
To add audio, click the [4dd Audia] button.

Add Audio

Ta set advanced audio settings, select [Sudia] and click the [8dvanced 5ettings] button.

Advanced Settings
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1 Click [Save].

Movies are saved in DCF type files with Motion JPEG/AVI compression.

7 ZoomBrowsen EX - C:\Documents and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

Edit Mavie dit results

Save file
1. AddImages File narne:

2. Anange

Save to folder

Help

‘ [ Browise

3 dopl Effect |C WDocuments and SettingstCanonity Documents
Save image type
4. SetAudio %) Auto-select
() Specify a save image ype
Save b PEC i
[Save image typ PEG [£41]
B Ewt Image Size:320 = 240 [Standard)

Frame Rate:15 Frames/secand
Audio 16 bit, 22.050 kHz, Monaural
(Total Time: 0010

Click [Save] button to save the edit results,

I 3 Retumn ta Main Menu l

Select this to save as Motion JPEG compressed AVI.

Advanced Sellings | e——

Selecting [Specify a save image type] and clicking [Advanced Settings] allows
you to set [Image Size], [Frame Rate] or [Audio] settings of the movie.

8 cClick [Exit].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

File Edit VWiew Tools Intermet Help

udio: 1 bit, 22.060 kHz, Monaural
otal Tirme: 00:10

Frame R ate:15 Frames/second
T

=

Click [Save] button to save the edit results.

Save

I Retum to Main Menu

Creating a Movie from the Still Images

Save filz —.
1. AddImages Bl ene:
|
2. Anange =
“ Save to folder:
3 Agply Effect | | ‘E'\Dncuments and Settings\Canonity Documents | [ Browsee } ‘
7 Save image type T i
4 Sethudio (=) Auto-select
() Specify a save image hype
Save RIREG [-/1] Sl Advanced Settings
; [Save image typetMotion) PEG (2v1]
Exit Image Size: 320 « 240 [Standard)




Playing Back Movies

In the CameraWindow and Main Window, movies are displayed with the first scene as

a still image with a (movie) icon.

2Py O Ifyou are not using Windows XP and QuickTime 6.5 or higher is not already
&z installed on your computer, install QuickTime 6.5 from the DIGITAL VIDEO
SOLUTION DISK.

o Do not double-click a movie file (.AVI extension) in Windows Explorer. That
will start Windows Media Player, which may not support this file type. To play
back movies, double-click the thumbnail with a movie icon in the Main

Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a

(movie) icon.

[Image Viewer] window appears.

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniiy Doc uments

File Edit View Tools Internet Help

[ Tasks @

@ Acquire & Camera Settings

Zoom Made | Sl Mode | Preview Mode

=
[F"_. Wiew & Classity

-

Favoite Falders | A Folders

=-{& Desktop
=l D My Docurment s
) 200%_01_20
ir *. My Music

,rjp Slide show ‘Q Search

_],_J-"‘ Show [ .&Ii‘\‘mages v:

F

MVI_D106 Ayl

0 1D7]3D1DEJPG i
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The [Image Viewer] window is displayed, and the movie will be played back.
You can control (Play back/Stop/FF/RW) the movie being played back with the
buttons shown at the left bottom of the window. If you are using Windows XP,
you can extract still images from the movie. For details, please refer to
Extracting Still Images from Movies (Windows XP Only) ([.I] 70).

You can save the displayed scene as a still image.

[=] ZoomBrowser EX - C:\Documents and) SettingsiCanoniMy DocumentsiVl_0106.AVI
File Edit View Help

@ g M Q‘g_j B3] et - Show: E'E 10 BB ==

¢ [l MYI_O106.AYI

p— S 4@ W™ W 2
ERLAEIV G W N W .
& iy, W B -

You can play movies and control the sound volume.
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| Exporting Images

You can change the data type for selected still images and movies and save them as
new files. You can also export selected movies and still image properties to a text file
or copy and rename movies and still images. Furthermore, you can export still images
for use as a screen saver or a wallpaper.

Changing the File Type and Save

1 Click [Export] in the Main Window.

£ ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

Fil= Edit View Tools Internet  Help

= =N
3/ Slids Show Q Search

[ Tasks 3]
@ Aeauire & Camera Settings ZoomMode | Serall Made | Preview Mnde_ 5 o
= My Documents € L R-0- k -8 _J,—-———""‘ Show | All Images w
’E_ Wiew & Classify
E 200_01_15 My Mugic

g Edit

E art

| Frint

l. Internet
2 Select the export type.

If you selected [Export Movies], [Extract frames from a movie] or [Backup to
CD], please refer to the pages listed below.

[Export Movies]: Exporting Movies ([1] 67)

[Extract frames from a movie]: Extracting Still Images from Movies (Windows
XP Only) ([.1170)

[Backup to CD]: Saving on CD-R/RW Disks (Windows XP Only) ([.1]73)

IMG_0101.0PG  IMG_0102, PG

£ ZoomBrowser EX - C:\Documents and Settings\Canontiy Documents

File Edit View Tools Internet Help

[ Tasks 6 ] | Tew Image 35 @ Slide Shaw @ Search

IF;:“ Yiew b Classify | e Zoom M de SCIOH Mode | Preview Mode _ o

= My Documents < R-0- & |® _}—f Show | All Images w
II@ Edit l |

r 200%_01 by Music
Export
fl Export Siill Images P H ‘ .
Export Movies | ‘ ‘
IMG_0101,0PG  IMG_0102. PG

Expart Shooting Properties

l Extract frames from a movie

Backup to CO

&= i

E— I =\
< IMG_0103.0PG  IMG_0104,1PG
Export as a ' allpaper
‘ | My Pictures
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=7 ZoomBrowser EX - C:\Documents and SettingsiCanoniby Documents

File Edit View Tools Internet Help

3 Select images and click [Specify Export Settings].

3 Retum to Main Menu

When you have selected [Export Still Images]:
You can convert still images to another file type, resize and save them as new files.

You can select the file type from BMP, JPEG and TIFF. You can also specify a prefix to
be added to the exported still images.

w1 ZoomBrowser EX - C:\Documents and Settings\Canonty Documents

File Edit ‘iew Tools Internet Help

= f xport setiings
1. Select Images Image Setings —_— ]
] Resize images during expor.
Specify Export Settings i T
— Lang side;
-
Short side:

iﬁ El ,g;\xels
b !

: stz =

mrT— | S .. Y

om0 Gy it & — — High
. 7

Original File ng@; BEH‘

’ Modified File Size: 0KB

File Mame Seﬁ?ﬁgﬁ‘— L _
abe D

Sawva to Folder _

il © Current Folder
‘ L O hy Pictures
O Specity Folder

Qﬁ?ﬁ‘bncumems and Settings\CanoniMy Documents

b

4 Specify the export settings and click [Finish].

The window varies depending on the selected export type in step2.

vou can reduce the amount of
ory your files use by
sizing the images to a smaller
size.

%{l";eh expoting images as

- JPEGs. you can also reduce fils
sizes by using a lower Quality
setting which compresses the
image more. The images won't
look as shamp butthe file sizes
will be smaller.

i, :
High guality  Low guality

J

Exporting Images

[EEIET

Help




When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

=1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

;-.2 Export Shooting Froperties

1. Select Images Export Settings Shooting properties are storad
Select shooting properties to export inimages as EXIF information
Specify Export Settings
Active AF Points el EXIF stands for Exchangeahle
[v] AF Mode I Image File Format and is used
(3 Finish AF Range Mode = by most camera manufacturers.,

utoexposure Bracketing e

Digital Exposure Compensation
[ Dinital Zanm

[ selectan |[  clearan |

[IE3

Retun to Main M
[ 9 Retumto Main benu -

Specify file narme and falder

‘C.\Ducumenls and SettingsiCan. AZBShootingProperties.hd

NOTE: Properties will he saved as * bt

Files without shooting properties will not be exported. j

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

o' ZoomBrowser EX - C:\Documents and Settings\CanoniMy Documents

File Edit View Tools Internst Help

@ Export as

The order inwhich you select

hotos determines their
= = [ Include images in the screen saver (largerfile size) i th
SDEDI“‘ E!(DD“ SB“IHQS SBOUENCE INthe SCreen sgwver.

7 \ ESIZE IMBLES 102:4x768 Ifyou selected to include
images in the screen sever, you
= = Screen saver size: KB Calculate can reduce their size to fit &

different screen resalution.

[ 1. Select Images ] Screen Saver Sefiings - _—_—

[[1Set as default screen saver
Ifyou choose notto include
J - images in the screen saver, and
wou then move or rename these
images, they will not display
when the screen saver plays

l Preview Screen Saver..

Save toFile ST

1 The screen sawverwil be saved as:
I (& "ZhScreenSaver.scr” in the default \Windows directony far
sCreen savers

O Specify file name and folder | Savaas

I Retumn to Main Menu

wTE' The screen saver will be saved using the file extension *scr j
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When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be
performed if you have selected multiple images.

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents |Z”E”z‘

File Edit View Tools Internst Help

L port as nape STEP 2: Specify the export setiings Help
] 1. Select Images ] ( Installation Setings Stretching small photos can \
pixelate and distort the photo
Specify Export S ettings ﬂ ® Install centered Try choosing Install centered ar
Installed tiled

= S e
O Install stretched Tiling replicates the phata, in its

original size, to fitthe desktop
O Install tiled

> B

© Donotinstall

Saveto File

[ 1 Returm to Main Menu The wallpaper will be saved as:

A

& "ZBWallpaperbmp" in the default directony forwallpapers

O Specify file name and folder

\NOTE' Wallpapers are saved as bitmap images (“bmp) /
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Exporting Movies
You can change the size or data for selected movies and save them as new files.

VG If you are not using Windows XP, QuickTime 6.5 or higher is required to export

\&¥ movies. If it is not already installed on your computer, install it from the
DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click QuickTime 6.5 [Install] in the installer panel.

1 Click [Export] in the Main Window.

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents

File Edit ‘iew Tools Intermet Help

j [ Tasks @ ] Trria P @ Slidz Shiow @ Search

e Eome IS g Zoom Mode | Scroll Mode | Preview Mode |

WEF' “wiew & Classify l
| L@ J 2004_071_20 T
‘ )

My Documents 4t HK-0- ‘LlE\ _]r—"'""' ShUW|A"‘mageS -
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l@ Export |
[ Export Still Images Jl I||
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| Expart Movies |

[ Extract frames from a movie

Expart Shooting Properties

|
G0 Mmmmw
5 P/

l Export as a Screen Saver
l Export as aWallpaper

Backup to CD
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3 Select a movie and click [Select the save image type].

You can select multiple images or a folder to include all images in that folder.
Still images cannot be selected. For instructions on how to export still images,
see Exporting Images ([ ] 63).

=1 ZoomBrowser EX - C:\Documents and SettingsiCanoniby Documents

File Edit View Tools Internet Help

) ExportMoviss STEP 1: Selact a movie Help

m Preview Mndel
My Documents € > 4 |@' a'lg]a Iah &) | :D: D— |Shnw

~ Select Movies

{ 2 Select the save image type )

—{
3. Setthe save image twpe

4. Specify name of file to be saved ’I

8. Start export

M_0106. AVI

&7 ZoomBrowser EX. - C:ADocuments and SettingsiCanoniby Documents

. Select Movies

- Select the save image type

(| 3 Setthe save image pe

4. Specify name of file to be saved

B Start export
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Specify the export settings and click [Specify name of file to
be saved].

1 ZoomBrowser BX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internst Help

1. Select Movies ﬂnage Size \

i &) No change

. 2. Select the save image type o oheo 502

| : ) Size specification 320« 240
Set the save image type

Fix the aspect ratio

. Specify name of file to be saved ) ErareEae

D e —— ~
Automatic w  Frames/second
5. Start export

Image Hualiy
-
.J ]
L Standard High
Audio

- Avtornatic b
[ 3 Return to Main Menu ] \ )

Specify the file name and click [Start export].

In each case, specify the destination folder and file name of the movie to be
exported.

7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniiy Doc uments

File Edit View Tools Internet Help

me of file to be

‘ 1. Select Movies File Marme zetting > . e

(&) Same as original image
[ 2. Select the save image type O ssilm coadlilt

abc b

‘ AoE

l 3. Setthe save image twpe

Save to folder

‘ C:ADocuments and Settings\Canonity Documents [ Browse

[5ave image type information]

Save image tppe:Motiond PEG A1)
= Image Size:Mo change

Frame Fiate:Automatic

Image Quali:Standard

Audior Automnatic

3 Retum to bain Menu

Destination Folder

Click [OK].

The Main Window appears.

MowvieExport Task

Export is completed.

Details =>
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Extracting Still Images from Movies (Windows XP Only)

You can extract still images from movies and save them as image files.

1 Click [Export] in the Main Window.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniby Documents |Z||EHX‘

File Edit View Tools Internet Help

[ Tasks 6] Vlew Image Propetties @Shde Shaw @Search ﬁ Delete |__.§| Rotate

Acquire & Camera Seltings Zoam Mode ‘ Scioll Mode | Preview Mndel
T =~ [ P =
My Documents € > 4 |@ -0 - |E]a g M | e D‘ | Show | Alllmages =
@ Wiew & Clagsify

|
|
Edit J’

File Edit ‘iew Tools Internet Help

[ Tasks °
@ Wiew & Classify ] i
h@ Edit

e

[ Export Still Images

|E| ‘iew Image PFroperties @Shde Show @ Search TEET Delete :_}’ Fotate

Zoom Mode | Seroll Mode | Freview Mode |

Iy Documents € 3 5 ! :::' :D: J_ Show | Alllmages |

[ Export Movies J
| Extract frames from a movie |

( Export Shooting Properties

Export as a Screen Saver ‘

Export as a Wallpapar
[ Backup to CO- .
S o n'

3 Select the movie from which you wish to extract still images
and click [Set extraction method].

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents

File Edit ‘iew Tools Internet Help

STEP1: S i Help [

§ Zoom Mode ‘ Serol Mode | Preview Mods |
elect movie

1 e by Documents > 4 E-Q- || K& = M| O j.._ | Show | Al mages v
(| 2 Set extraction method ) :

3 Preview image:

4. Setupzave ’I

5. Perform processing
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4 Select the still images extraction method and click [Preview
image].

* [Extract all frames]: Extracts all frames in the movie as still images.

* [Specify an interval and extract frames]: Extracts frames as still images from a
specified frame range or time interval.

* [Specify the number of copies and extract frames]: Extracts a specified
number of still images from the entire movie. The extraction interval is
calculated based on an equal distribution of the specified number of still
images.

* [Extract a specified image]: Extracts still images from scenes that catch your
attention.

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniy Documents
Flle Edit ‘View Tools Inkermet  Help

l 1. Select movie

L Set extraction method

-
{

File mame: Y01 06441

Play time: 00:07.00
Total frames: 105
Image Size: 320240

& . it
, Select how ta extract the still images from the movie
() Extract all frames

Preview image
o

4. Setupsave

\

Extracts every frame in the movie as a stil image.

J
i
|

l 5. Perform processing

() Specily an interval and extract frames
w Specilies the interval at which stil images are extracted from the mavie,
s
(7 Spexify the number of copies and extract frames
B R Specilies the number of copies of stillimages to be extracted from the mavie.

E B |:| Copies

() Extract & specified image

__| vy Extracts the frame pou select while watching a preview of the movie as a stil
“. ) image.
\ - /

3 Retum to Main Menu

-l
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5 Confirm the still images which will be extracted (images with
checkmarks) and click [Set up save].
If you selected [Extract a specified image] in the previous window, the movie will

be displayed in the upper part of the window. Display the images you want and
click [Add].

1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

File Edit View Tools Internet Help
;:j Exiract frames from a movie STEF 3 he image. Help

1

Select movie Original movie file

File: name:kY1_0108.4%1
| Play tire:00:07.00

Total frames:105

Image Size: 3204240

2 Setextraction method

Preview image

—

Selup zave

|
E——
7

8 Peiform processing

[ 3 Return to Main Menu ]

@ » : Changes the thumbnail size.
% - : Rotates all still images.

i il i
sElnnk Clears or adds check marks to all still images at once.

i # T, : Clears the check marks of all the still images before/after the
selected still images.

6 Specify the file name and the folder where you wish to save
it and click [Perform processing].

w1 ZoomBrowser, EX - C:\Documents and Settings\Canonikly Documents

File Edit VYiew Tools Intermet Help

: File Marme
1. Select movie 7 ;
(&) Use ariginal movie file name

@h@ ) Specily a file name

2. Setemtraction method

3. Preview image

L Set up save J
= — —
)

=

Save folder

) Save in same folder as original movie
a.\ - ) Specily the save folder
| Browse

Autn folder crestion

. Perform processing

() Automatically create a folder with the same name as the original movie

Gne:lw folder name for auto crestion /

[<Save Cantents>

Saved images: 105

Image Size:320x240

|H equired disk space.Approx. 2.8MB

iSave to folder: C:AD ocuments and SettingshCanonsty Documentsh2000s_01_2004Y]_0106

(s reminirs ]
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Saving on CD-R/RW Disks (Windows XP Only)

You can copy and save images to CD-R or CD-RW disks. The shooting information is

copied along with the images
’0\ This function can only be used on a computer that came with a CD-R/RW drive E
\&¥/ as standard equipment.

1 Place a CD-R/RW disk in the computer’s CD-ROM drive.

2 If the following window appears, click [Cancell].

CD Drive (F:)

windows can perform the same action each time you inzert
a dizk or connect a device with this kind of file:

(5] Blank CD
wihat do you want Wwindows to do®?

Lisi :.l 3 : :n B
® Take no action

|
AN

[ Always do the selected action.

3 Click [Export] in the Main Window.

&7 ZoomBrowser EX - C:\Documents and Settings\Canoniy Doc uments

File Edit View Tools Internet Help

> ) . d
[ Tasks (2] ] ]| Wigp 1 Ometties Dp Slide Show a Search elate
@ Acquire & Camera Settings ] | Zoom Mode Scioll Made | Preview Made

[F‘_" My Documents
lﬁg-‘ Wiew & Classify

Edit

-
©

LB N_/L [ ¥

IMG?DID 1IPG IMG 0102 0FG
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4 Click [Backup to CD].

&7 ZoomBrowser EX - C:\Doc nonkky Documents

File Edit View Tools Internet Help

[ Tasks 6] Vlew Image Properties @Shde Shaw @Search ﬁ Delete @Ratata

@ View & Classity @J Zoom Mode ‘ Scrol Mode ” Preview Mudel
My Documents € > 4 ||5"0,'|@. Q ) | :D: D-‘ |3hUW

Edit

@ Export

Export Still Images

Expart Movies

Extract frames from a movie

Export as a Screen Saver

~

(| | e e
i

[ Expart Shooting Properties

Export as a '\ allpaper

5 Select the folders or images you wish to save and click
[Specify Backup Settings].

pomBrowser EX - C:\Documents and Setti Canoniyy Documents

File Edit ‘iew Tools Internet Help

&
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6 Set the backup settings and click [Start Backup].

The disk will be ejected from the drive when copying is complete.

=1 ZoomBrowser EX - C:\Documents and Settings\Canon'y Documents

File Edit View Tools Internst Help

wpto CO

Select Images ( Backup Setings The speed atwhich your ’

computer writes (burns) data to
‘ Select CO-R Drive:

the CD affects the CD guality.

Specify Backup Settings

| CD Title: | ‘ In general, slower recording
< 3. StartBackup ) speeds create CDs that are less
1= —_— = Speed |Fa5t95t "‘ prane to erors.
[ Werity atter backup Itis atways a good idea to
choose “erify after backup'to

Use the Verify feature to tast the data an the CD-R after hackup is ensure that the backup was
complete. This will take longer. butwill determine whether the backup was successful
successiul.

Space on CD-R:

[ 1 Retmia bain e Usged 0.00 B, Current Seseion 122,81 KB, Remaining 702.70 ME

@ I

100 200 300 400 500 00

(1] Thefile sizes above are estimates only. The CO buming process
may not he completed if the remaining space is low.

o J

2% You can add images to a CD-R/RW disk that already contains images.
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Adding Still Images to the Memory Card in the
Camcorder

You can add still images (JPEG) from the computer to a memory card in the
camcorder. You can also save sample images for card mix from the DIGITAL VIDEO
SOLUTION DISK.

’0\ o Unable to upload the still images to the disc.

\&¥ o When using this function, you cannot add the still images to a memory card
using a card reader/writer. Please insert the card to the camcorder to add
images.

B Adding Still Images to the Memory Card
1 Connect the camcorder to the computer ([ 25).

2 Click [Acquire & Camera Settings] in the Main Window.

£ ZoomBrowser, BX - C:A\Documents and SettingsiCanoniy Doc uments g‘

File Edit View Tools Internet Help

= =N
3/ Slids Show Q Search

Zoom Mode | Scrall Made | Preview Mode|

My Documents < 4+ EH-0- ‘ll & _J,—-———""‘ Shiow AII.\mages w

3] 200¢_01_15

[ Tasks 6 } | i Wiew Irmag: 5 @ Slide Show I@ Search )3
‘:’@ AN & Comelgitiilngs J Zoom Mods | Scroll Mode | Preview Mode _all” _ : ‘
p— N My Documents € 4+ ER-0- | kR e Show | Allimages v]

200)(7017? My Music
7

7’
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4 Click the [Set to Camera] tab and click [Uploads images to

the camera).

¢ CameraWindow - Canon ¥ ¥4 ¥

Acquire Images Prinl'] Set to Camera |!43mote shooting |

| e Set My Camera

Confirmsf{changes camera settings

Uploads images to the camera

Diizplayz thiz screen when the camera iz connected

5 Select the still images you wish to save and click [Open].

Upload Images from Disk

Loak in: |T'_J 2004_01_15

IMG_0103

File riame:  |'IMG_D102JPG" "IMG_0101 JPG"

Files of type: | jmeal* ira]

—=>

| Cancel

6 Select the image size and click [Add].

Add image

Image will be added after zetup iz performed.

X

(%) Add image as is
() Send after changing the image to WG size (40480 dats)

Cancel

’0\ When you upload images edited with another application, images properties

\&¥] may be lost.

Exporting Images I 77




B Adding Card Mix Sample Images to the Memory Card

You can save sample images for card mix to the memory card in the camcorder.
CARD CHROMA, CARD ANIMATION, CARD LUMINANCE and CAMERA CHROMA
are provided on the DIGITAL VIDEO SOLUTION DISK.

@ o The sample images provided on the supplied DIGITAL VIDEO SOLUTION
\ o/ DISK are intended only for personal use with this camcorder. Do not use
these sample images for other purposes.
O Unable to upload the card mix sample images to the disc.

1 Connect the camcorder to the computer ([1] 25).

2 Insert the DIGITAL VIDEO SOLUTION DISK to the
computer’s CD-ROM drive.

If the installer panel opens, click [Exit] to close it.

3 Click [Acquire & Camera Settings].

£ ZoomBrowser EX - C:\Documents and SettingsiCanonitiy Documents

File Edit View Tools Internet Help

= N
3/ Slids Show Q Search

Zoom Mode | Serall Mads | Preview Mode|

by Documents L 3 L k -0 -

3} 200¢_01_15

File Edit Wiew Tools Internet Help

[ Tasks Q I ‘ fiew Image o5 @ Slide Show r@ Search
l@ Acquire & Camera Settings J Zoom Made | Scroll Mode Freviewbode| = =
e My Diocumen s € 4+ R-0- || h® | how | Almages v
‘ Connec! t to Camera ‘
Fﬂ zuuxfuw My M

“I8
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5 Click the [Set to Camera] tab and click [Uploads images to
the camera).

& CameraWindow - Canon %+ %

Acquire Images Prinl'] Set to Camera |!43mote shooting |

Set My Camera

e
%F Confirms/{changes camera settings

Uploads images to the camera

Diizplayz thiz screen when the camera iz connected

6 In [Look in:], select the CD-ROM icon, and double-click [DVC

CARD IMAGE].
Sample images or folders for CAMERA CHROMA, CARD ANIMATION, CARD

CHROMA and CARD LUMINANCE appear.

Upload Images from Disk:

Loak ir: | @ CanonD T [E:] v_i Q ¥ e M-

o O

AANLIAL QUICKTIME

v

File: name: | i [ Open ]

Files af type: i|peg[*.|pg] v' [ Cancel ]

/4 Select the sample images you wish to save and click [Open].

Upload|Images from Disk. @El
Lok in: | [ CARD LUMINANCE ¥ Q@ F -
~
‘ " \
J L
R
AUT_0009,.JPG AUT_0010.JPG AUT_0011.JPG
v
File rarne: |"AUT,DD11 JPGE" AUT_0003.JPG" ALT_001 |
Files of type: |ipeg[”.ipg] v| [W]

Exporting Images I 79



8 In the Add image window, click [Add].

The sample images are saved in the memory card.

80 I Exporting Images

x)

fdd/image

Image will be added after zetup is performed.

() Add image as iz
() Send after changing the image ta YGA size [E40480 dats]

Cancel




| Using Various Functions

Merging Panoramic Images (PhotoStitch) E

You can merge a series of overlapping still images into a single, seamless panorama.
PhotoStitch automatically arranges still images recorded with the camcorder’s Stitch
Assist mode in their correct order and orientation, making it easy to merge them.
Please refer to the Camcorder Instruction Manual to learn how to record in Stitch
Assist mode.

The following instruction explains how to merge still images recorded in Stitch Assist
mode with the camcorder.

’0\ Still images recorded in Stitch Assist mode with Wide-converter or Tele-
\E¥] converter attached cannot be merged correctly.

1 Select still images shot in Stitch Assist mode.
To use PhotoStitch, images need to be shot in Stitch Assist mode. To download
images, please refer to Downloading Still Images (ZoomBrowser EX) ([ 1] 27).

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Doc umentsi200 01153 TITCH_4796

File Edit View Tools Internet Help

[ Tasks 6] g iew Image Propetties @Shda Shaow @ Search ﬁ Delete lj.é‘] Rotate
@ Aequire & Camera Seftings l Zoom Mode \Sclo\IMode= Preview Mods | _ P e
= STITCH_4796 € 4 B0 oy k| RE _],-—!-‘ Show | Allimages =
EE) Wi & Classify l
l@ Edit l
l@ Export l

l@ Frint
: l Internet

| | Favarite Foldersi All Folders | 1
= ﬂé] Desktop
= h'__‘ My Documents
LMD 200%_01_15
5 |3 STITCH_479%6
i (=] My Music |
" My Pictures
9 My Computer
4 Search Resulks

o |

Add to Favarites ]

Selected Trems: 4
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2 Click [Edit].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documentsk200X_01_15iSTITCH_4796

File Edit Yiew Tools Intermet Help

[ Tasks

@ Acquire & Camera Settings
'\@ “wiev & Classify

=

4\@ Edit

1N

F@ Export

@ Frint

A3

Internet

3 click [Stitch Photos].
PhotoStitch starts.

View Image Properties @Shde Show @Search ﬁ Delete @Rntate

Zoom Mode ‘ Serol Mode | Preview Mods |

STITCH_479% € + [Bm-0-[[(n& & 7| = et Show [ Allmages v

.It_ @)

.\

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documentsk200% 01 15iSTITCH 4796

Fil= Edit View Tools Internet  Help
Vlewlmage 5 Propetties @Shdeshow @SEarch ﬁ Delete I@Ratate

Zoom Made | Scral Mode | Preview Made |

STITCH_4736 €2 2 (E-0-[n]q e Show | Allimages -

[ Tasks

L Acquire & Camera Settings
@ Wiew & Classify
[@ Edit

LE dit Image

| Stitch Phatos

2

7\
S\ | N N

Edit Movie

(===

4 Arrange the order of the still images and click [2. Merge].

Operational instructions are displayed in the upper section of the window.

Merge Images Shot in Stitch Assist Mode
CRK[Z Maige] to mtige these images
Fox images shok as 8 Wdegsee pancrama. chck [Amange]
select [ 350 Degrees] and Sen chok [2 Mege]

s and Anagennark

" T 3] = ¥
Dgan.. Sradch Cles Fhotats Enbage

STA_DSTHIPG STE_DSTHJPG STC_DSS0PE ST0_0561.JP6

s of i 4 V4768 Trum Cikn y:
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5 Cclick [Start].

7._Selscsion snd Aargermack ] 2 e

STD_051.0P6 |

STC_DRsIPG

STA_DSTHIPE STE_DSTUIPE

oo, o a4 Farvny (Scmery, i} Foal Uth : fukis R - Canen

6 Select [3. Save] and then click [Save].
» Select the destination folder, input the file name and click [Save].
* In the View the Saved Image? window, click [Yes]. The Viewer window opens
and displays the merged image.
« To exit PhotoStitch, from the [File] menu, select [Exit].

[8=1E3)

Fie ESt View Mege Hep

. Save Image
2 e[S b 5t rieped i
T menge = difiesent image. setum io 1. Selection and Anangement]
3 ehek [Cheai] and then [Cleas 40
Sabachi drwoenat || Misios
7

riage Som : ARSI

@ O You can record the surroundings in 360 degrees, and stitch them together

= later to form a 360-degrees cylinder. (In [1. Selection and Arrangement],
select [Arrange] and [360 Degrees].) By saving this stitched image in
QuickTime VR type, you can then get a virtual view of the surroundings by
manipulating the mouse. For this, you need to have QuickTime installed on
your computer. Ifitis not already installed, install it from the DIGITAL VIDEO
SOLUTION DISK. Place the disc in the CD-ROM drive and click QuickTime
[Install] in the installer panel.

O Please refer to the PhotoStitch Help menu for more details.
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Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

’0\ To use this function, the e-mail software must be enabled as MAPI client. For
\&¥/ details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents

File Edit Yiew Tools Internet Help

I[ Tasks [=] ]I . @ Slidz Show ‘a Search
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L

Fil= Edit View Tools Internet  Help

[ Tasks (A ] l’jP Slide Show @ ssarch (] D
- i
@ Aquire & Camera Settings Zoom Mode | Serall Made | Previewtods|

= by Documents € -
[':Pi\ i & Classify
l@ -~ E 200_01
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(g
l@ Export
l@ Frint
{@ Intemnet

| Email Images

/. |

7\l
| N
]

3 Select the still images you wish to send and click [Change
Image Size].

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanon\ky Documents

File Edit ‘iew Tools Internet Help

'{@ Email Images

ZoomMode | Serall Mode | Preview Mode
Select Images - - p— — - — ]
= e ———— = My Documents € 4t | R-0- ‘_k_!“!{* _]ff— e .__A" Images v

| 2. Change Image Size

D —

4) 200 _01_15 by Music
3. SendorSave

J
~
4. Finigh l

—

[ 9 Fetum to Main Menu ] H IMG_DID3.]PG IMG_U]-D.“.‘JPG.
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Select image size and quality, and click [Send or Save].
If you wish to send the still image without changes, select [Send images
unchanged]. Normally select [Resize and compress images into JPEG type].
- [Long side/Short side]: Selects the long or short side and sets the image size
in numbers.
- [Quality]: The lower the quality, the coarser becomes the still image and
smaller the file size.
- Pressing [Calculate] displays the file size after the compression as [Modified
File Size].
- You can check the compressed still image by pressing [Preview Images].

7 ZoomBrowser B£ - C:\Documents and Settings\CanoniMy Documents

File Edit Yiew Toaols Internet Help

'\r@- Email Images

{5t > 2: Change the quality
' Vel S You may want o reduce the size ‘

l 1. SelectImages

] Sl h d andfor quality of the photos to a
L Change Image Size J |§| o B iegEs R tatal file size of less than 300 KB
—_— © Resize and compress images into JPEG type Thiz insures that peopls can
7 N receive your email
[ 2 SendorSave J © Long side: ;
= —_— = Decrease the file size ofthe
4 Finish = . exported photas by reducing
’7 e T @ EI |8 | el the dimensions. ZoomBrowser
E¥ maintains the photo's aspect
Izl tatio duting resizing
© Shart side
= —
i N
le—l
Qualiby: Highest
I Retum to Main Menu
You can also reduce the quality
Criginal File Size 828 KB ofthe photo. The image may not
i il laok &= sharp. butthe file size
Miodified File Size: 0.0 bytes Ealcul W = nlier
() ‘Whenthe image size is large, the images may not be sent properky by
wour ermail program. A total size of 300KB is recommencled.

\
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5 Select to send still images by e-mail or to save the still
images in a folder and click [Finish].

* If you selected [Create a new email], your e-mail software starts and the
selected still images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail software
not supporting MAPI does not start automatically. In this case, select [Save the
images in a folder...].

« If you select [Save the images in a folder...], click [Browse] and select the
destination folder. Start your e-mail software and attach the saved still image
to a message.

7 ZoomBrowser EX - C:\Documents and Settings\CanonMy Documents

File Edit Yiew Toals Internet Help

"'\r@ Email Images STEP 3 Send the email or save itto send later Help

l 1. Select Images Email Seftings I your email program supports

MAPL you can attach the photos
directly from ZoomBrowser Ex.

@ Create & new email

2. Change Image Size

|
|
L Send or Save J

(1) This option is only available ifwou use an email program that
supponts MAPL. e.q. Microsoft Outlook Express.

Otherize, you need to sawve the
photos in afolder. start your
email program, and then attach
) Sawve the images in afolderto send through an email program that does the photos to a new email

not support MaP!

Then:

1. Startyour preferred email grogram.
2. Aftach the images to an email as normal and send

3 Retum to Main Menu
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Running a Slide Show

You can view selected still images in a slide show. Movies cannot be selected for a
slide show.

1 Click [View & Classify] in the Main Window.

You can also view a slide show by clicking [Slide Show] on Application Tool Bar.
Please skip forward to step 4.

&7 ZoomBrowser EX. - C:ADocuments and SettingsiCanonidy Documents
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l@ Export
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IMG_0101.0PG IMG_0102. PG

B I

2 Click [View as a Slide Show].
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= l My Documents £ A9 R-0 - Eﬁ% ™ J,-f—""‘ Shows | Al Images ~

ﬁ'—j Wiew & Classify J 7 ¥ |
)

Zoom Mode | Serall Mode Presview Mode |

| View as 2 Slide Show
D

Rename Multiple Files

Clazsify inta Falder

Search

File Edit VYiew Tools Intermet Help

Select Images

= ty Documents L L 3 _Q -0 - ‘Il'ﬂa _]rf—""" Show | Al Images ~

2. Setup Slide Show r’

= 3} 2002 01 15 iy Music
3. Start Slide Show...

J Zoom Made | Seroll Mods Preview Mode |
J

.

J[ I Retum to Main Menu ] ’H
A
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4 Select the slide show settings.

* [Image Size]: Select the size of the still images.

* [Image Information]: Select to show image information such as file name or
title.

 [Advance to Next Slide]: Select to advance manually or automatically. When
you select “Every 3 second(s)”, you can select the interval in the control below
(from 1 to 120 seconds).

* [Loop]: Select to stop the slide show after the last image or to continuously run
itin a loop.

* [Transitions]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

1 ZoomBrowser B% - C:ADocuments and Settings\Canon\My Documents

1. Select Images ]

|
|

3. Start Slide Show... ]

Imﬁge Size O Actual Size
© BestFit
| 9 Aetum to Main bteru © Meximum Stretch

Image Information: © Mo Infarmation
& Show Information
© Controls Only

Advance to Next Slide: @& On clicking the left mouse buttan
O Ewvery 3 second(s)

j— ’:”‘_\ . - 3 J

B Click [Start Slide Show].

Click in the lower right corner to end the slide show.
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Adding Sound to a Still Image

* You can add a sound to an image. The sound file needs to be in WAVE type
(extension “.wav”) or in MIDI type (extension “.mid” or “.midi”).
* The sound cannot be played back on the camcorder. E
1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

2 View Tools  Internet  Help

Copy ChrlH-C
Copy ko Folder. ..
Miove bo Folder ...
Select all Chrl+a
Clear Selection Crrl+R

Rokate Image...
Rakake According o Ratation Information

Change Star Batine

U'

Edit Image. ..
M My
| Manags My Camera

2 Click [Add].

ak. ] [ Cancel

3 Select the sound file and click [Open].
4 Cciick [OK].

» The sound file will be copied to the same folder as the image.
« To play back the sound, select an image with a sound icon and select [Play
Sound] from the [Edit] menu.

2Py © To remove sound from an image, select [Remove] on the Sound window in
& step 2. |1 disappears and the copied sound file will be deleted.
o The [Play Sound] window appears and plays back the sound.

Using Various Functions I 89



Reviewing and Changing the Owner Name of the

Camcorder

You can change and confirm the owner name of the camcorder.

1 Connect the camcorder to the computer (1] 25).

2 Select [Canon CameraWindow] and click [OK].

Canon * & 44

Camera connected

Select the program to launch for this action:

vl anon Cameraiaindow

pt Y- - -
[ 01iloads Images From Canon Came

=

S Microzoft Scanner and Camera wizard

Download pictures from a camera or scanner

[ &hways uze this program for this action

(
l Cancel ]

3 Click the [Set to Camera] tab and click [Confirms/changes

camera settings].

90 I Using Various Functions

ﬂ CameraWindow - Canon &% # 4 %
rﬁcquire Images || Print %emote shooting

| o

Set My Camera

Confirms/changes camera settings

_‘_@l Uploads images to the camera

Displays thiz screen when the camera is connected




4 Enter the camcorder’s owner name and click [OK].

£ Camera Settings

Camera Model. Canon ko
Firnwuare Yerzion; 1.0.0.0

Owner's Mame:
Input a camcorder owner name ——— tCanon |
here (up to 31 characters).

L 0k _,,J [ Cancel ] [ Apply
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| Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

’0\ Users of Windows 2000 and Windows XP must first log in as an Administrator
\&¥] to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs] »

[Canon Utilities] » [ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

i Internet ) My Documen ts
Internet Explorer

# E-mail f'j My Pictures
Lﬂ" Cutlook Express @r St Program Access and Defaulks
W Windows Catalog
.!’ MSH Explorer % windows Update
® ‘windaws Media Play: I Accessories
o M Canon Utiliies I Camerawindow
I .
'\'{.‘E Windows Movie Makell () Games 1) E0S Utiliy

- I Startup
g T “ind P
@ ournaaws & Internet Explorer

1M3M Explorer
@ ZoomBrowser Ex “ P

LS?] Outlook Express

IF) Photostitch
I} RAW Image Task

13
3
IE) MovieEdit Task  »
b
b
b

ﬁ ZoomBrowser EX

i:, Remate Assistance [Z] ZoomBrowssr EX Readme

(‘) ‘Windows Media Player % ZoomBrowssr Ex Uninstall

| All Programs . 3 ‘Wwindows Messenger
@] Log CFf @| Turn OFf Computer
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o Other programs in [Canon Utilities] can also be uninstalled in the same way.
o Uninstall all programs in [Canon Utilities] when you have uninstalled
ZoomBrowser EX.
o RAW Image Task is used with Canon digital camera. The camcorder does

not support the program, but you can uninstall the program in the same way
as uninstalling the ZoomBrowser EX.
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Uninstalling the TWAIN Driver/WIA Driver

Connect the camcorder to the computer ([1] 25).

[E]

If a window for selecting an application program or the
Scanners and Cameras Wizard appears, click [Cancel]. If
ZoomBrowser EX started, close it.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation ([_] 95).

Windows 98/Windows 2000:
1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.
2. Click [OK] to close the window.
3. Turn the camcorder POWER switch to OFF and remove the USB cable from
the computer.
4. Click the Windows [Start] menu and select [Programs], [Canon Utilities], [DV
TWAIN Driver x.x] and [TWAIN Driver Uninstall].
A version number appears in place of “x.x”.
Windows Me:
1. Delete the camcorder icon from the [Scanners and Cameras] folder.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon Ultilities], [DV
WIA Driver x.x] and [WIA Driver Uninstall].
A version number appears in place of “x.x”.

When the Confirm Uninstall window appears, click [OK].
The uninstall process starts.

When the Maintenance Complete window appears, click
[Finish].
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| Troubleshooting

Connection

Camcorder is not recognized when connected to the computer.

= Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the
following requirements. Acquire the necessary system to use the USB interface.
Requirements: Built-in USB port on a system pre-installed with Windows 98,
Windows Me, Windows 2000, or Windows XP.

= There is no disc or memory card in the camcorder.
Insert a disc or a memory card into the camcorder.

= The camcorder is not set to the correct mode.
Turn the power switch to ON and change the camcorder mode to PLAY by
sliding down the power switch. Move the '® /¢y to 3. Then, select DISC or
CARD in the MEDIA SEL.&3 from the SYSTEM SETUP menu.

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([]] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

= If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

> TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the DIGITAL
VIDEO SOLUTION DISK (remove the check marks from the other programs
when prompted to select the programs to be installed).

ZoomBrowser EX Operation

Cannot download still images.
= The camcorder is not set to the correct mode.
Turn the power switch to ON and change the camcorder mode to PLAY by
sliding down the power switch. Move the '™ /¢y to 3. Then, select DISC or
CARD in the MEDIA SEL.63 from the SYSTEM SETUP menu.

Image files or folders do not appear in ZoomBrowser EX.
= Images or folders shown in ZoomBrowser EX and the actual file contents
may be different when an image file has been moved or copied using
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation

Cannot install the TWAIN Driver/WIA Driver correctly.
= Does the system have a built-in USB port and did it come with Windows
98/Windows Me/Windows 2000 preinstalled? (For Windows XP, no driver
is necessary to be installed.)
= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([1] 25) and check the
connection.
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Ensure that you are using the correct cable and that its connectors are in good
shape.
= Are you using the power adapter to power the camcorder?
= If the problem is not mentioned above, the TWAIN Driver/WIA Driver may
not have been recognized by Windows.
Uninstall and reinstall the driver. (For Windows XP, no driver is necessary to be EI
installed.)

TWAIN Driver/WIA Driver Uninstallation

If you have problems when uninstalling the driver, use the following procedures to
remove it.

’0\ The [Inf] folder contains numerous files that are critical to the computer’s
\&¥] operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

N Use the procedures below for the following circumstances too.

- If you do not find [Scanners and Cameras] in the [Control Panel] or
[Printers and Other Hardware].

- If [Canon Camera] or your camcorder model name does not appear in the
[Scanners and Cameras Properties] or [Scanners and Cameras].

- If you connected the camcorder to the computer via the USB cable before
installing the Digital Video Software.

Windows 98/Windows Me

Leave the camcorder connected to the computer.

O
W

1 Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
The [System Properties] dialog appears.

Click the [Device Manager] tab.

W DN

If [Canon Camera] appears under the [Other Devices] and/or
[Imaging Devices] categories, use the following procedures
to delete it.

1. Select [Canon Camera] and click [Remove].

2. In the confirmation dialog, click [OK].

3. Click [OK] to close the [System Properties] dialog.

5 Double-click the [My Computer] icon on the desktop
followed by the [C:] drive and the [Windows] and [Inf]
folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
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3. Windows 98: Set the [Hidden files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden files
and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
In the [Inf] folder, double-click [Other] folder to open it.

Find and delete the [Canon.IncCAPxxx.inf] and
[Canon.IncCDVxxx.inf] file.
* The xxx represents numerals.
« If the above file is not contained in the [Other] folder, you do not need to delete
anything.

Windows 2000

Leave the camcorder connected to the computer.

AP LON -

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
Click the [Hardware] tab.
Click the [Device Manager] button.

If [Canon Camera] or your camcorder model name appears
under the [Other Devices] and/or [Imaging Devices]
categories, use the following procedures to delete it.
1. Select [Canon Camera] or the name of the camcorder model, right-click the
mouse button and select [Delete].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
Remove all copies of [Canon Camera] or your camcorder model name that
appear in the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.

Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. In the [Advanced setting] section, set the [Hidden files and folders] category
to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check mark.
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4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

T Look for the file for Canon digital camcorders starting with
[Oem*]. [E]

» A number such as “0” or “1” will appear in place of the asterisk (*) above. You
will also find another file called [Oem*.pnf], which will have the same number
as the [Oem®.inf] file. The two constitute one set.

» There may be many file sets starting with “Oem”.

* If you double-click an [Oem*.inf] file, the Windows Notepad program will start
and show the file contents. Click each [Oem*inf] file until you find one that
contains “*** Canon Camera Driver Setup File*™*” in its first line. When you
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.

Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct
files.

If You Were Using ZoomBrowser EX Version 2 or 3
(This manual explains version 5.x)

Titles and comments added using a prior version than ZoomBrowser EX
version 4 do not appear in ZoomBrowser EX 4 or higher.
= Titles and comments added using a prior version of ZoomBrowser EX will
not be displayed. Use the following procedure to display them.

1. In Windows Explorer, open the [Program] folder under the folder in which you
installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbconverter.exe].

3. Select the database you were using until now (C:\Program Files\Canon\
ZoomBrowser EX\Program) and click the [Start] button.

Please note that with ZoomBrowser EX 4 or higher, both titles and comments
appear in the comment list.

Cannot find the image folders saved with a prior version than ZoomBrowser
EX 5.x.
= Image folders saved under the [Program Files] folder (such as [Image

Library One]) cannot be displayed in the Main Window’s Folder Area of

ZoomBrowser EX 4 or higher. Use the following procedure to display

them.

1. In Windows Explorer, open the [Program Files] folder under the folder in
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\lmage Library One).

2. Select the image folder you wish to display and copy the folder to a different
destination.
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